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4 INFORMATION TECHNOLOGY 

E-commerce (electronic commerce) is the buying and selling of goods and services, or the 

transmitting of funds or data, over an electronic network, primarily the internet. These 

business transactions occur either as business-to-business (B2B), business-to-consumer 

(B2C), consumer-to-consumer or consumer-to-business. The terms e-commerce and e-

business are often used interchangeably. The term e-tail is also sometimes used in reference 

to the transactional processes that make up online retail shopping. • In the last decade, 

widespread use of e-commerce platforms such as Amazon and eBay have contributed to 

substantial growth in online retail. In 2007, e-commerce accounted for 5.1% of total retail 

sales; in 2019, e-commerce made up 16.0%. E-Commerce • How does e-commerce work? • 

E-commerce is powered by the internet, where customers can access an online store to 

browse through, and place orders for products or services via their own devices. • As the 

order is placed, the customer's web browser will communicate back and forth with the server 

hosting the online store website. Data pertaining to the order will then be relayed to a central 

computer known as the order manager -- then forwarded to databases that manage inventory 

levels, a merchant system that manages payment information (using applications such as 

PayPal), and a bank computer -- before circling back to the order manager. This is to make 

sure that store inventory and customer funds are sufficient for the order to be processed. After 

the order is validated, the order manager will notify the store's web server, which will then 

display a message notifying the customer that their order has been successfully processed. 

The order manager will then send order data to the warehouse or fulfilment department, in 

order for the product or service to be successfully dispatched to the customer. At this point 

tangible and/or digital products may be shipped to a customer, or access to a service may be 

granted. • Platforms that host e-commerce transactions may include online marketplaces that 

sellers simply sign up for, such as Amazon.com; software as a service (SaaS) tool that allow 

customers to 'rent' online store infrastructures; or open-source tools for companies to use in-

house development to manage. Introduction to Electronic Commerce • Types of e-commerce 

• Business-to-business (B2B) e-commerce refers to the electronic exchange of products, 

services or information between businesses rather than between businesses and consumers. 

Examples include online directories and product and supply exchange websites that allow 

businesses to search for products, services and information and to initiate transactions 

through e-procurement interfaces. • In 2017, Forrester Research predicted that the B2B e-

commerce market will top $1.1 trillion in the U.S. by 2021, accounting for 13% of all B2B 

sales in the nation. • Business-to-consumer (B2C) is the retail part of e-commerce on the 

internet. It is when businesses sell products, services or information directly to consumers. 

The term was popular during the dot-com boom of the late 1990s, when online retailers and 

sellers of goods were a novelty. • Today, there are innumerable virtual stores and malls on the 

internet selling all types of consumer goods. The most recognized example of these sites is 

Amazon, which dominates the B2C market. Introduction to Electronic Commerce • 

Consumer-to-consumer (C2C) is a type of e-commerce in which consumers trade products, 

services and information with each other online. These transactions are generally conducted 

through a third party that provides an online platform on which the transactions are carried 

out. • Online auctions and classified advertisements are two examples of C2C platforms, with 

eBay and Craigslist being two of the most popular of these platforms. Because eBay is a 

business, this form of e-commerce could also be called C2B2C -- consumer-to-business-to-

consumer. • Consumer-to-business (C2B) is a type of e-commerce in which consumers make 

their products and services available online for companies to bid on and purchase. This is the 
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opposite of the traditional commerce model of B2C. • A popular example of a C2B platform 

is a market that sells royalty-free photographs, images, media and design elements, such as 

iStock. Another example would be a job board. • Business-to-administration (B2A) refers to 

transactions conducted online between companies and public administration or government 

bodies. Many branches of government are dependent on e-services or products in one way or 

another, especially when it comes to legal documents, registers, social security, fiscals and 

employment. Businesses can supply these electronically. B2A services have grown 

considerably in recent years as investments have been made in e-government capabilities. 

Introduction to Electronic Commerce • Consumer-to-administration (C2A) refers to 

transactions conducted online between individual consumers and public administration or 

government bodies. The government rarely buys products or services from citizens, but 

individuals frequently use electronic means in the following areas: • Education. 

Disseminating information, distance learning/online lectures, etc. • Social security. 

Distributing information, making payments, etc. • Taxes. filing tax returns, making payments, 

etc. • Health. Making appointments, providing information about illnesses, making health 

services payments, etc. • Mobile e-commerce (M-commerce) is a type of e-commerce on the 

rise that features online sales transactions made using mobile devices, such as smartphones 

and tablets. M-commerce includes mobile shopping, mobile banking and mobile payments. 

Mobile chatbots also provide e-commerce opportunities to businesses, allowing consumers to 

complete transactions with companies via voice or text conversations. E-Commerce 

Framework • What is an e-commerce framework? • The term e-commerce framework is 

related to software frameworks for e-commerce applications. They offer an environment for 

building e-commerce applications quickly. • E-Commerce frameworks are flexible enough to 

adapt them to your specific requirements. As result, they are suitable for building virtually all 

kinds of online shops and e-commerce related (web) applications like the Aimers e-

commerce framework does. • An e-commerce framework must • allow replacing all parts of 

the framework code • forbid changes in the framework code itself • contain bootstrap code to 

start the application • be extensible by user-written code E-Commerce Framework • E-

Commerce frameworks should • define the general program flow • consist of reusable 

components • be organized in functional domains • Examples of e-commerce frameworks are 

• Aimers (Laravel, Symfony, TYPO3, SlimPHP, Flow) • Spryker (Symfony only) • Sylius 

(Symfony only) • They provide an overall structure for e-commerce related applications. 

Furthermore, they implement the general program flow e.g. how the checkout process works. 

Contrary to monolithic shop systems, existing program flow can not only be extended but 

completely changed according to your needs. E-Commerce Framework • Evolution of e-

commerce systems • Since the beginning of (internet) e-commerce around 1995, a lot has 

changed on the technology side. The first generation of e-commerce systems evolved from 

existing ERP and related systems. This was followed by the 2. generation of standalone shop 

systems between 2004 and 2008. E-commerce frameworks are the latest generation of e-

commerce systems and started around 2012. • Hybris, the shop system owned by SAP is one 

of the representatives of the 1. generation. It’s strongly connected to the SAP ERP system 

and Hybris is mainly a shop front-end for SAP. Customer relationship (CRM) and content 

management (CMS) tools are available in the ERP system but very limited. • The Magento 

shop system represents the 2. generation of standalone e-commerce systems. They usually 

contain CRM and CMS and some other functionality but also only at a very basic level. They 

might be enough for the smallest shops but are unusable for shop owners who run for real 
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profits. • Aimeos is one of the few real e-commerce frameworks that are currently available. 

These 3rd generation systems excel in their own domain: Present and sell products. For all 

other e-commerce related tasks, they connect to specialized systems and exchange data in 

both ways. Thus, shop owners can choose the best systems for their needs. E-Commerce 

Framework • E-Commerce framework architecture • E-commerce frameworks must be based 

on a strong architectural model. Usually, they make heavy use of interfaces and design 

patterns like • Dependency Injection (make components independent of used object 

implementation) • Factories (create objects at a central place that instantiates the actual 

implementation) • Decorators (dynamically add functionality to existing objects) • 

Publish/Subscribe model (notify listening objects about changes instead of polling for 

updates) • A “design pattern” is re-usable solution that solves similar software design 

problems in an elegant way. They require programming language templates which enforce 

public class methods and their signatures called “interfaces”. • The basic requirement is 

independent, side-effect free components that form the building blocks. One or more 

components care about the functionality of a business “domain”. Such a domain can be the 

HTML front-end, a JSON REST API and the administration interface. E-Commerce 

Framework • The vertical separation of code into business domains enables scaling out 

applications by deploying the application as a bunch of micro services. • Micro services are 

loosely coupled applications that offer their service over lightweight protocols like HTTP and 

JSON. They are easier to extend, maintain and especially deploy than monolithic 

applications. E-Commerce and media convergence • Media Convergence The electronic 

marketplace is turning into a reality as many companies are using their resources and talents 

through mergers with other companies. The term E-Commerce is now irreversibly linked 

with the idea of convergence of companies cantered on information like content, storage, 

networks, business applications, and consumer devices. • Convergence means merging of 

consumer electronics, publishing, television, computers, and telecommunications for the 

purpose of enabling new forms of information-based commerce. The concept may be 

confusing for the public as the popular press uses the terms multimedia and cross media 

interchangeably. Multimedia convergence refers to the conversion of data, voice, text, image, 

graphics, and full-motion video into digital content. Cross-media convergence applies to the 

integration of various industries, such as, entertainment, publication, and communication 

media based on multimedia content. The two types of convergence are closely related to each 

other. E-Commerce and media convergence • In the new era of interactive television, the 

lines between advertisements, entertainment, education, and services often become blurred. 

While watching a World Cup cricket match between India and Australia, you may develop an 

urge to know more about Australia. Instead of running to the local bookstore and purchasing 

a book, you can connect to an online database and search while not missing any part of the 

match. The information in these online databases is not limited to text but also provides 

photographs and digital videos (multimedia). • In other words, convergence requires 

removing the barriers between telecommunications, broadcasting, computing, movies, 

electronic games, and publishing industries to facilitate interoperability. E-Commerce and 

media convergence • Simple technological improvements driving the phenomenon of 

convergence are as follows: • 1. Convergence of Content: This helps to translate all types of 

information content, such as, books, business documents, videos, movies, and music into 

digital information. Once the content is converted into digital form, that information can 

easily be searched, encrypted, duplicated, and transmitted which suits today’s information 
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processing systems. • 2. Convergence of Transmission: This helps to compress and store 

digitized information so that it can be transmitted through existing phone and cable wiring. 

New techniques and other technological discoveries modify all types of information. Here, 

we can notice the convergence of communication systems that provide a medium to transmit 

voice, data image, and video without rewiring the neighbourhood. • 3. Convergence of 

Information: Some of the information access devices can function as both computers and 

televisions. For example, a telephone with internal fax machine, modem, and video monitor 

is capable of receiving fax, e-mail, and video E-Commerce and media convergence • 

Convergence is also being driven by certain market conditions including the following: • 1. 

The availability of low-cost, high-performance enabling component technologies, such as, 

semiconductors, storage and display devices, communications systems, and operating 

systems. • 2. Entrepreneurs’ expectation of end-user demand for new applications—both 

products and services that rely on the above-mentioned enabling technologies. • 3. The 

regulatory actions that are creating competition in monopoly markets, such as, local and long-

distance communications, telecommunication and cable equipment, and facilitating the rapid 

deployment of the new applications Anatomy of E-Commerce Applications • Anatomy of E-

Commerce applications • •Multimedia Content for E-Commerce Applications • •Multimedia 

Storage Servers & E-Commerce Applications • I. Client-Server Architecture in Electronic 

Commerce • ii. Internal Processes of Multimedia Servers • iii. Video Servers & E-Commerce 

• •Information Delivery/Transport & E-Commerce Applications • •Consumer Access Devices 

• Multimedia Content for E-Commerce Applications • •Multimedia content can be considered 

both fuel and traffic for electronic commerce applications. • •The technical definition of 

multimedia is the use of digital data in more than one format, such as the combination of text, 

audio, video, images, graphics, numerical data, holograms, and animations in a computer 

file/document. See in Fig. • •Multimedia is associated with Hardware components in different 

networks. • •The Accessing of multimedia content depends on the hardware capabilities of 

the customer. Anatomy of E-Commerce Applications • Multimedia Storage Servers & E-

Commerce Applications • •E-Commerce requires robust servers to store and distribute large 

amounts of digital content to consumers. • •These Multimedia storage servers are large 

information warehouses capable of handling various content, ranging from books, 

newspapers, advertisement catalogues, movies, games, & X-ray images. • •These servers, 

deriving their name because they serve information upon request, must handle large-scale 

distribution, guarantee security, & complete reliability • I. Client-Server Architecture in 

Electronic Commerce • •All e-commerce applications follow the client-server model • 

•Clients are devices plus software that request information from servers or interact known as 

message passing • •Mainframe computing , which meant for “dump” • •The client server 

model, allows client to interact with server through request-reply sequence governed by a 

paradigm known as message passing. • •The server manages application tasks, storage & 

security & provides scalability-ability to add more clients and client devices( like Personal 

digital assistants to Pc’s. See in fig. Anatomy of E-Commerce Applications • ii. Internal 

Processes of Multimedia Servers • •The internal processes involved in the storage; retrieval & 

management of multimedia data objects are integral to e-commerce applications. • • •A 

multimedia server is a hardware & software combination that converts raw data into usable 

information & then dishes out. • • •It captures, processes, manages, & delivers text, images, 

audio & video. • • •It must do to handle thousands of simultaneous users. • •Include high-end 

symmetric multiprocessors, clustered architecture, and massive parallel systems. • Anatomy 
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of E-Commerce Applications • iii. Video Servers & E-Commerce • The electronic commerce 

applications related to digital video will include • 1. Telecommunicating and video 

conferencing • 2. Geographical information systems that require storage & • navigation over 

maps • 3. Corporate multimedia servers • 4. Postproduction studios • 5. shopping kiosks. • 

•Consumer applications will include video-on-demand. • •The figure which is of video–on 

demand consist video servers, is a link between the content providers (media) & transport 

providers (cable operators) • Anatomy of E-Commerce Applications • Information 

Delivery/Transport & E-Commerce Applications • •Transport providers are principally 

telecommunications, cable, & wireless industries. • • Information Transport Providers 

Information Delivery Methods • • •Telecommunication companies long-distance telephone 

lines; • local telephone lines • •Cable television companies Cable TV coaxial, fibre optic & • 

satellite lines • •Computer-based on-line servers Internet; commercial on-line • service 

providers • •Wireless communications Cellular & radio networks; • paging systems Anatomy 

of E-Commerce Applications • Consumer Access Devices • • Information Consumers Access 

Devices • • •Computers with audio & video Personal/desktop computing • capabilities Mobile 

computing • • •Telephonic devices Videophone • • •Consumer electronics Television + set-

top box Game • systems • •Personal digital assistants (PDAs) Pen-based computing, voice- • 

driven computing E-Commerce Consumer and Organization Applications • E-Commerce 

Consumer and Organization Applications • People needs entertainment on demand including 

video, games, news OnDemand, electronic retailing via catalogues etc. • • Currently now we 

are taking the video on-demand. • • Why most companies betting heavily on this? • 1. 93 

million homes have television • 2. Americans spend nearly half their free time watching 

television • 3. Every evening, more than one-third of the population is in front of a television 

• 4. Sight, sound, and motion combine to make television a powerful means of marketing E-

Commerce Consumer and Organization Applications • 1. Consumer Applications and Social 

Interaction: • • Lessons from history indicate that the most successful technologies are those 

that make their mark social • • In 1945, in U.S no one had TV. By 1960 about 86percent of 

households did • • Now contrast with Telephone. Bell invented the telephone in 1876 and 

by1940, 40% of U.S. households and by 1980 about 95-98 percent of households connected • 

• Penetration was slower for Telephone than for TV because of the effort needed to set up the 

wiring infrastructure • The impact of both was good on business, social, consumer behaviour 

and entertainment habits • Radio began in 1960, and by 1989, almost 3 decades later, just 319 

radio stations followed the news format • In 1994, their number exceeded 1000 E-Commerce 

Consumer and Organization Applications • What do Consumers really want? • 1. They want 

quality and cost of service • 2. If a new system requires more steps to do essentially the same 

things, consumers may resist it • 3. Some people fit that mold, but most of public prefers to 

lay back and just watch television and let someone else do the work of figuring out the 

sequence of television programming • What are Consumers willing to spend? • 1. According 

to the video on-demand, consumers get the cable bill at basic charge they will buy • 2. If it is 

doubled, they will not buy and at the service provider economics will increased then network 

operators might look to advertises to fill the gap E-Commerce Consumer and Organization 

Applications • Delivering products to Consumers • 1. Packing and distribution must be 

considered • 2. Blockbuster video collects the information and shows the typical consumer • 

3. Spends $12 a month on home video expenditures • 4. Go to video store to select video on 

limited budget and has time to kill • 5. Only periodically expends a large sum of money The 

network Infrastructure for Electronic Commerce • Network infrastructure is required for e-
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commerce to transport content. I-way is a high-capacity, interactive electronic pipeline used 

to transfer content in case of ecommerce. I-way can transfer any type of context like, text, 

graphics, audio, video. In other words, multimedia contents are easily transported through I-

way. • Components of I-way: - Consumer access equipment. - Local on-ramps, and - Global 

information distribution networks. Consumer access equipment are devices used by 

consumers to access the multimedia interactive contents of e-commerce. In this segment, 

hardware and software vendors are also included. The network Infrastructure for Electronic 

Commerce • Local or access road, or on-ramps: This segment of I-way simplify linkages 

between businesses, universities, and homes to the communications backbone. There are four 

different types of providers of access ramps: - telecom-based - cable TV-based - wireless-

based and - computer-based online information services. These providers link users and e-

commerce application providers. • Global information distribution networks are the 

infrastructure that is connecting countries and continents. The network Infrastructure for 

Electronic Commerce • INFORMATION SUPERHIGHWAY (I-Way) Any successful E-

commerce application will require the I-Way infrastructure in the same way that regular 

commerce needs the interstate highway network to carry goods from point to point. A myriad 

of computers, communications networks, and communication software forms the nascent 

Information Superhighway (I-Way). The I-Way is not a U.S phenomenon but a global one, as 

reflected by its various labels worldwide. For instance, it is also called the National 

Information Infrastructure (NII) in the United States, Data-Dori in Japan and Jaring, which is 

Malay for "net" in Malaysia. The I-Way and yet-to-be developed technologies will be key 

elements in the business transformation. And while earlier resulted in small the network 

Infrastructure for Electronic Commerce • gains in productivity and efficiency, integrating 

them into the I-Way will fundamentally change the way business is done. These new ideas 

demand radical changes in the design of the entire business process. I-Way is not one 

monolithic data highway designed according to long-standing, well-defined rules and 

regulations based on well-known needs. The I-Way will be a mesh of interconnected data 

highways of many forms: telephone wires, cable TV wires, radio-based wireless-cellular and 

satellite. The I-Way is quickly acquiring new onramps and even small highway systems. 

Market forces influencing the I-way • What are market forces? • Market forces are the factors 

that influence the price and availability of goods and services in a market economy, i.e. an 

economy with the minimum of government involvement. • Market forces push prices up 

when supply declines and demand rise, and drive them down when supply grows or demand 

contracts. When demand equals supply for a product or service, the market is said to have 

reached equilibrium. • To supply means to provide something that is wanted, i.e., to make it 

available. • Invisible hand • Adam’s Smith’s ‘invisible hand’ referred to market forces. • 

British moral philosopher and pioneer of political economy, Adam Smith (1723-1790), cited 

by many as the father of modern economics, wrote in his books about the ‘invisible hand’ 

that determined levels of supply, demand, the prices of goods and services, as well as wealth 

creation and distribution. Market forces influencing the I-way • The prices of goods and 

services are driven by the forces of supply and demand, i.e., market forces. This ‘invisible 

hand’ represented market forces – supply and demand – and how if left to its own devices, an 

economy could thrive. • Mr. Smith’s influence spread across the world and is often quoted by 

economists who support the market economy. • Mr. Smith wrote: • “Every individual 

necessarily labours to render the annual revenue of the society as great as he can. He 

generally neither intends to promote the public interest, nor knows how much he is promoting 
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it … He intends only his own gain, and he is in this, as in many other cases, led by an 

invisible hand to promote an end which was no part of his intention. Nor is it always the 

worse for society that it was no part of his intention. By pursuing his own interest he 

frequently promotes that of the society more effectually than when he really intends to 

promote it. I have never known much good done by those who affected to trade for the public 

good.” • In other words, the invisible hand is essentially a natural phenomenon that drives 

free markets through competition and scarce resources. • Market forces influencing the I-way 

• Market forces can push and pull either upwards and downwards or forwards and backwards. 

The push/pull forces on demand and supply regulate prices. In this context, backwards means 

the same as downwards, while forwards equal upwards. Examples of market forces • When a 

cold snap hits Florida, the price of orange juice across supermarkets in the United States 

rises. When the weather turns sunny and warm in northern USA, prices of hotel rooms in 

Cancun decline. • The price of gasoline across the world rises when major wars break out in 

the Middle East. Also, the sale of large gas-guzzling SUVs drops. • What do all these events 

have in common? They all show how market forces affect supply and demand. They also 

show that they ultimately affect the price of goods and services. • Market forces determine 

how much of each good we produce, and at what price they go on the market. • If anybody 

wants to know how an event or policy will affect the economy, they must think first about 

how it might affect supply and demand. Market forces influencing the I-way • Market vs. 

command economies • In so-called market economies, governments try not to intervene and 

allow market forces allocate resources. Prices bring supply and demand into equilibrium, and 

they guide decisions of producers and consumers. • In centralized or command economies, 

the government tries to supplant these decentralized decisions with its own. North Korea and 

Cuba, for example, are command economies. In command economies, the market does not 

set prices. • George Soros, a Hungarian-born American business magnate, investor, author, 

and philanthropist, said: • “If we care about universal principles such as freedom, democracy, 

and the rule of law, we cannot leave them to the care of market forces; we must establish 

some other institutions to safeguard them.” Market forces influencing the I-way • Market 

forces influencing the I-Way: • Demands and Requirements of market participants. The 

failure and success of any product or service is a factor of market forces. To become a reality, 

Ecommerce needs a network infrastructure to transport the content also known as the 

electronic interactive or multimedia I-Way. The I-Way has become the leading word. • The 

principal drawback of existing communication infrastructure lies in its inabilities to provide 

integrated voice, data and video services. Thus a business user requiring voice , data and 

video conferencing services often had to use three separate networks such as voice network, 

data network and video conferencing network. This understanding is important because e-

commerce applications are dependent on the underlying I-way. • Until recently the market 

place was fragmented into communication , entertainment and information sectors. the 

following two points worth considering are • Market forces influencing the I-way • 1. The 

boundaries among communication are not absolute. • Ex: Video is a part of Information, 

entertainment and communication. • 2. The boundaries among equipment are absolute. • Ex: 

Today technology exists to allow television sets and pcs to interact or exchange any sort of 

data. The emerging compatibility results in the flexibility needed to take advantage of new 

services. The expectations of I-way are on demand publishing, real time video conferencing, 

telemarketing, tele medicine, tele communication etc. • The cable industry wants to expand 

services from tv programming or paper view services such that the consumer can pay bills, 
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shop or check stock prices Components of I-way • Components of I-Way: The major 

components of I-way are 1.Consumer access equipment’s. 2. Ramps 3. Global Information 

Distribution Network. • 1. Consumer Access Equipment : It is often ignored component of I-

way but represent critical category. The absence of slow progress in which holding of up 

other segments of I-way. This segment of I-way includes hardware and software vendors who 

provide physical devices such as computer software platforms such as browsers and operating 

system • 2. Ramps: they simplify the leakages to schools and home to the communication 

backbone. This component is often called as last mile because they provide links. The 

providers of access ramps can be differentiated into four categories viz. telecom based , cable 

tv based, wireless based & computer based. Online information services. The backbone 

access provides links and uses e-commerce application providers. Components of I-way • 

3.Global Information Distribution Networks: The development of new communication 

technologies and continued employment of fibre optic facilities has resulted in higher 

transmission speeds at significantly low cost. The end result is a seamless web called the I-

way of communication network, computer digital libraries and compute electronics that will 

put vast amount of information at user’s finger tips. The two major technologies under 

pinning high speed global information distribution networks are a) long distance networks b) 

satellite networks Components of I-way • a) Long distance network: Long distance 

connectivity is available through cable ( coaxial ) or (fibre) owned by long distance 

interchange carriers (Ixc) Submarine cables provide an attractive economic advantage for 

selected rules, where growth advantage for selected rules, where growth is in demand and 

communication capacity is high. The Ixc’s also play a significant role in the local access 

market by teaming with firms in the wireless and cable tv business. Ixc’s are exploring 

alternative arrangements that would lower the cost of using the local network. Uniform speed 

efficiency, levels of technology and cost of telecom services are necessary for both voice and 

data services. Fibre optics have emerged as technology of choice because it is capable of 

providing higher bandwidth than satellite also it is immune to electromagnetic interference. 

Long distance network infrastructure is now been deployed under seas to carry international 

traffic. Components of I-way • b) Satellite network: Satellite networks have advantages over 

terrestrial network and they are accessible from any point on the globe. Satellite networks can 

provide broadband digital services including voice, data and video to many points without the 

cost of wide installation. Wide range of services include broadcast radio, video and overseas 

telephone links. Thus communication satellites are the crucial part of the global 

communication and infrastructure. Network Access Equipment • The Ultimate Guide to 

Network Access Equipment • Long before the introduction of cell phones, we used to have 

the early telephones. For these phones to work, operators would sit in a room where they 

received calls then connect the calls to the respective recipients. This means that instead of 

one calling the other person directly, as we can now, the caller had to go through the central 

hub for them to reach the recipient. That is, they will call the central hub, tell them whom 

they want to speak to, and then the operators at the central hub would call the recipient and 

connect them with the caller. • With technological advancement, we no longer have to go 

through a central hub to connect. Our devices do all the connecting on their own. When these 

devices connect, they form a hub, much like the central hub during the first telephone. 

Nowadays, the hub is known as the network. By using network access equipment, you can 

connect your smart gadgets such as smartphones and computers. Network Access Equipment 

• What is network access equipment? • A network access equipment is applied in boosting, 
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switching, splitting, directing, or combining data via a telecommunications or computer 

network. The equipment includes switches, gateways, multiplexers, hubs, transceivers, 

firewalls, and routers. The equipment can also be in the form of a protocol such as Ethernet, 

an interface, or a port. The equipment enables users to connect to a particular network such as 

the internet. • Through this equipment, phones can communicate with each other when linked 

through the same central hub (network). Network Access Equipment • How Network Access 

Equipment Works • The most important function of the equipment in-network access is to 

enable data to be shared among the various devices connected to the network. In wired 

networks, the devices connect according to how they relate with the design as well as the 

structure of the network in question. The devices also have to be in line with the network 

topology. • A network topology refers to the way the nodes have been arranged and the 

connections of the network. Some of the most popular computer network topologies include 

ring, bus, tree, star, and mesh. When it comes to wireless networks, the network access 

equipment alk’ to each other through radio waves, unlike in wired connections where wires 

are used, the wireless network requires no wires since the radio waves are sufficient for the 

communication between the various devices. Network Access Equipment • The network 

protocol is another critical factor to consider. Network protocols are important because they 

interpret the various rules that control network communication. It is their interpretation that 

enables users to communicate efficiently via the network. • Types of network access 

equipment • The following are some of network access equipment. • Hub • Bridge • Gateway 

• Router • Wireless Access Point (WAP) Network Access Equipment • Hub • This tiny, 

rectangular device sends all the signals it receives to the devices connected to the same 

network. Often made of plastic, the inexpensive device receives power from a regular wall 

outlet. Hub sends information packets to the various gadgets regardless of data packet’s MAC 

address. • Bridge • Bridges centralize the administration of the network by interconnecting 

remote as well as local networks hence creating a bigger inter-network. Based on the MAC 

address of the data packets, bridges can either forward or reject the data packets. Network 

Access Equipment • Gateway • A gateway enables users to communicate. It is a crucial 

stopping point for data because it connects networks with various communication protocols. 

With the gateway, networks can connect regardless of their difference in the communication 

protocol. They make data transfer faster and efficient by regulating traffic between different 

networks. • Router • A router is a device that is dependent upon the protocol in connecting 

sub-networks as well as dividing a rather large network into rather small networks. Routers 

can forward data packets to their exact IP address via other routers, or the other pieces of the 

data equipment. Most of the time, routers are used to connect home computers to an internet 

connection via the home network. Network Access Equipment • Wireless Access Point 

(WAP) • WAP allows wireless gadgets to access as well as communicate with the network. 

Hence, it is a bridge between traditional network, wired as well as wireless devices. WAP 

also connects wireless devices to other WAPs where the devices are also linked. • Conclusion 

• Hopefully, the above information has answered the questions that you may have had 

concerning network access equipment. Be sure to share this information with your loved ones 

so that they too can get the knowledge. E-Commerce and World Wide Web • What is the 

World Wide Web? • Everyone is today well aware of ecommerce. Let’s know about the 

World Wide Web or WWW as it is known. The WWW is a browser or web browser that lets 

users’ access web pages and web programs. The browsers include Internet Explorer, Firefox, 

Opera, Safari, and Google Chrome. The first page displayed on a website is termed as the 
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Home Page. The web pages provide links of other web pages which is known as surfing or 

browsing. A web page owns a unique address known as the Web Address or URL. The 

tabbed browsing lets you open and accesses multiple Web Pages in a single browser. There 

are two types of search tools, Subject Directory that classifies the Web Pages in different 

categories, and Search Engine that searches information regarding a specific topic. • 

Refreshing the meaning of ecommerce; it is a business transaction that occurs on the 

electronic network. An email or electronic mail is the transfer of information using the 

network. You can compose, send, receive, forward, save, print, and delete your emails. This 

email communication is facilitated by the World Wide Web E-Commerce and World Wide 

Web • The history of the WWW and Ecommerce • When the internet was first invented 

during the 20th century, its use was limited to government organizations, researchers, and 

universities for a long time. The hidden commands were what restricted and unsuited for 

businesses to use the internet. With the invention of electronic mails or e-mails, organizations 

started using the internet. Earlier organizations employed the internet for internal as well as 

external communication in the company. In the year 1989, an easier way to communicate and 

share information through a network known as the World Wide Web was invented in the 

CERN laboratories by Tim Berners-Lee. This was when businesses started using the internet 

as a way of business by sharing information for their growth. E-Commerce and World Wide 

Web • With the trend of internet connection and web browsers becoming the new normal, 

businesses started purchasing domain names and aimed at creating a website. In 1991, the 

restrictions on the commercial use of the internet were lifted by the National Science 

Foundation. Two of the most successful ecommerce giants today, Amazon and eBay, were 

established back in the year 1994. In the late 1900s, the rush in the ecommerce business 

investment led to the dot-com bubble and in the early 2000s, the dot-com bubble busted. 

Although the dot-com bubble had a few drawbacks, it helped in internet connections were 

laid around the globe for thousands of miles during the time. After this was the beginning of 

the globalization era. With the emergence of the digital world, the threats imposed by worms 

and viruses through sharing increased at a dreadful pace. Later, a whole new industry of 

internet security and the computer emerged. Architectural framework of E-Commerce • 

ARCHITECTURAL FRAMEWORK OF E COMMERCE • The software framework 

necessary for building electronic commerce applications is little understood in existing 

literature. • In general a framework is intended to define and create tools that integrate the 

information found in today’s closed systems and allow the development of e-commerce 

applications. • It is important to understand that the aim of the architectural frame-work itself 

is not to build new database management systems, data repository, computer languages, 

software agent based transaction monitors, or communication protocols Rather, the 

architecture should focus on synthesizing the diverse resources already in place in 

corporations to facilitate the integration of data and software for better applications. 

Architectural framework of E-Commerce • The electronic commerce application architecture 

consists of six layers of functionality, or services: • (1) Applications; • (2) Brokerage 

services, data or transaction management; • (3) Interface, and; support layers” • (4) Secure 

messaging, security and electronic document Interchange; • (5) Middle ware and structured 

document interchange; and • (6) Network infrastructure and basic communications services • 

These layers cooperate to provide a seamless transition between today’s computing resources 

and those of tomorrow by transparently integrating information access and exchange within 

the context of the chosen application. As seen in table above, electronic commerce 



THAKUR COLLEGE OF SCIENCE AND COMMERCE 

 DEPARTMENT OF INVESMTENT MANAGEMENT 
 

 

14 INFORMATION TECHNOLOGY 

applications are based on several elegant technologies. But only when they are integrated do, 

they provide uniquely powerful solutions. Architectural framework of E-Commerce 

Application services Customer- to- business Business- to- business Intra-organizational 

Brokerage and data management Order processing Payment advances-electronic cash Virtual 

mail Interface layer Interactive catalogues Directory support functions Software agents 

Secure messaging Encrypted e-mail, EDI Remote programming Middle ware services 

Structured documents (SCML,HTML) Compound documents Network infrastructure 

Wireless - cellular, radio, PCs Wire line – POTS, coaxial, fibre optic WWW and its 

architecture • The World Wide Web abbreviated as WWW and commonly known as the web. 

The WWW was initiated by CERN (European library for Nuclear Research) in 1989. • 

History: It is a project created, by Timothy Berner’s Lee in 1989, for researchers to work 

together effectively at CERN. is an organisation, named World Wide Web Consortium 

(W3C), was developed for further development in web. This organisation is directed by Tim 

Berner’s Lee, aka father of web. WWW and its architecture • System Architecture: From 

user’s point of view, the web consists of a vast, worldwide connection of documents or web 

pages. • Each page may contain links to other pages anywhere in the world. • The pages can 

be retrieved and viewed by using browsers of which internet explorer, Netscape Navigator, 

Google, Chrome, etc are the popular ones. • The browser fetches the page requested interprets 

the text and formatting commands on it, and displays the page, properly formatted, on the 

screen. • The basic model of how the web works is shown . • Here the browser is displaying a 

web page on the client machine. When the user clicks on a line of text that is linked to a page 

on the abd.com server, the browser follows the hyperlink by sending a message to the 

abd.com server asking it for the page hypertext publishing • Hypertext is an approach to 

information management where the data is stored in network of documents and these 

documents are connected by links. • Here the documents are taken as nodes and links 

represent the relationship between the documents and nodes. • As the documents are known 

as nodes similarly the links are known as the pointers. • The nodes or documents may contain 

text, graphic, animation, audio video, images or programs. • In same system the nodes and 

system network itself is viewed through browsers and are manipulated, edited with the help 

of structure editor. • We see that different nodes are connected by links or pointers. The node 

from which the link gets started is known as reference or anchor and the node at which it ends 

is called referent. • The movement between nodes is made possible by activating links which 

connect related concepts or nodes. Links can be of bi directional providing backward 

traversals, referential, hierarchical. • In some browser’s hypertext is a very simple context lies 

in its ability to produce large, complex, richly connected and cross referenced bodies of 

information. hypertext publishing • protocols are defined as agreed upon rules to be followed 

upon between two applications. These can also be defined as agreed upon format for 

transmitting data between two devices. The protocol determines the following. a. The type of 

error checking to be used. b. Data compression method if any. c. How the sender device 

indicate that it is sending the data. d. How the receiver device indicate that it is receiving the 

data. The protocol can be implemented either in hardware or in software. The different types 

of protocols. 1. top/ip transmission control protocol or internet protocol 2. Http Hypertext 

transfer protocol 3. Smtp Simple mail transport protocol hypertext publishing • Hypertext 

Publishing Web provides a functionality necessary for e-commerce. • The web has become 

an umbrella for wide range of concepts and technology that differ markedly in purpose and 

scope which include hypertext publishing concept, the universal reader concept and the client 
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server concept. • Hypertext publishing promotes the idea of seamless information world in 

which all online information can be accessed and retrieved. In a constant and simple way 

hypertext publishing is a primary application of web interest in hypermedia. • On the internet 

( called distributed or global hypermedia). • As accelerated shortly following the success of 

web media and browser. • This success has been aided by more powerful work station high 

resolution graphic display faster network communication and decreased cost for large online 

service. Technology behind the web • Information providers ( publishers ) run programs 

called servers from which the browsers can obtain information. These programs can either be 

web servers that understand the hypertext transfer protocol ( HTTP ) , “gateway” programs 

that convert an existing information format to hypertext, or a non-HTTP server that web 

browsers can access i.e. FTP or Gopher servers. • Web servers are composed of two major 

parts. • 1. the hypertext transfer protocol ( HTTP ) for transmitting documents between 

servers and clients . • 2. HTML format for documents. The link between HTML files & 

HTTP server is provided by Uniform Resource Locator (URL ). Security and the Web • What 

is Web Security? • Web security is also known as “Cybersecurity”. It basically means 

protecting a website or web application by detecting, preventing and responding to cyber 

threats. • Websites and web applications are just as prone to security breaches as physical 

homes, stores, and government locations. Unfortunately, cybercrime happens every day, and 

great web security measures are needed to protect websites and web applications from 

becoming compromised. • That’s exactly what web security does – it is a system of 

protection measures and protocols that can protect your website or web application from 

being hacked or entered by unauthorized personnel. This integral division of Information 

Security is vital to the protection of websites, web applications, and web services. Anything 

that is applied over the Internet should have some form of web security to protect it. Security 

and the Web • Details of Web Security • There are a lot of factors that go into web security 

and web protection. Any website or application that is secure is surely backed by different 

types of checkpoints and techniques for keeping it safe. • There are a variety of security 

standards that must be followed at all times, and these standards are implemented and 

highlighted by the OWASP. Most experienced web developers from top cybersecurity 

companies will follow the standards of the OWASP as well as keep a close eye on the Web 

Hacking Incident Database to see when, how, and why different people are hacking different 

websites and services. Security and the Web • Essential steps in protecting web apps from 

attacks include applying up-to-date encryption, setting proper authentication, continuously 

patching discovered vulnerabilities, avoiding data theft by having secure software 

development practices. The reality is that clever attackers may be competent enough to find 

flaws even in a fairly robust secured environment, and so a holistic security strategy is 

advised. • Available Technology • There are different types of technologies available for 

maintaining the best security standards. Some popular technical solutions for testing, 

building, and preventing threats include: • Black box testing tools • Fuzzing tools • White box 

testing tools • Web application firewalls (WAF) • Security or vulnerability scanners • 

Password cracking tools Support Systems • Management support • A large category of 

information systems comprises those designed to support the management of an organization. 

These systems rely on the data obtained by transaction processing systems, as well as on data 

and information acquired outside the organization (on the Web, for example) and provided by 

business partners, suppliers, and customers. • Management reporting systems • Information 

systems support all levels of management, from those in charge of short-term schedules and 



THAKUR COLLEGE OF SCIENCE AND COMMERCE 

 DEPARTMENT OF INVESMTENT MANAGEMENT 
 

 

16 INFORMATION TECHNOLOGY 

budgets for small work groups to those concerned with long-term plans and budgets for the 

entire organization. Management reporting systems provide routine, detailed, and voluminous 

information reports specific to each manager’s areas of responsibility. These systems are 

typically used by first-level supervisors. Generally, such reports focus on past and present 

activities, rather than projecting future performance. To prevent information overload, reports 

may be automatically sent only under exceptional circumstances or at the specific request of a 

manager. Support Systems • Decision support systems and business intelligence • All 

information systems support decision making, however indirectly, but decision support 

systems are expressly designed for this purpose. As these systems are increasingly being 

developed to analyse massive collections of data (known as big data), they are becoming 

known as business intelligence, or business analytics, applications. The two principal 

varieties of decision support systems are model-driven and data-driven. • In a model-driven 

decision support system, a preprogramed model is applied to a relatively limited data set, 

such as a sales database for the present quarter. During a typical session, an analyst or sales 

manager will conduct a dialog with this decision support system by specifying a number of 

what-if scenarios. For example, in order to establish a selling price for a new product, the 

sales manager may use a marketing decision support system. It contains a model relating 

various factors—the price of the product, the cost of goods, and the promotion expense in 

various media—to the projected sales volume over the first five years on the market. By 

supplying different product prices to the model, the manager can compare predicted results 

and select the most profitable selling price.  
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 • A management information system (MIS) is an information system used for decision-

making, and for the coordination, control, analysis, and visualization of information in an 

organization.  

• The study of the management information systems involves people, processes and 

technology in an organizational context.  

• In a corporate setting, the ultimate goal of the use of a management information system is to 

increase the value and profits of the business. This is done by providing managers with timely 

and appropriate information allowing them to make effective decisions within a shorter 

period of time Management Information System (MIS)  

• What is MIS? Introduction & Definition  

 What is MIS?  MIS is the use of information technology, people, and business processes to 

record, store and process data to produce information that decision makers can use to make 

day to day decisions. The full form of MIS is Management Information Systems. The purpose 

of MIS is to extract data from varied sources and derive insights that drive business growth. 

Management Information System (MIS)  

 The need for MIS - The following are some of the justifications for having an MIS system  

• Decision makers need information to make effective decisions. Management Information 

Systems (MIS) make this possible.  

• MIS systems facilitate communication within and outside the organization – employees 

within the organization are able to easily access the required information for the day to day 

operations. Facilitates such as Short Message Service (SMS) & Email make it possible to 

communicate with customers and suppliers from within the MIS system that an organization 

is using. 

 • Record keeping – management information systems record all business transactions of an 

organization and provide a reference point for the transactions. Role and Impact of MIS  

• IMPACT OF THE MANAGEMENT INFORMATION SYSTEM  

• MIS plays a very important role in the organization; it creates an impact on the 

organization’s functions, performance and productivity.  

 The impact of MIS on the functions is in its management with a good MIS supports the 

management of marketing, finance, production and personnel becomes more efficient. The 

tracking and monitoring of the functional targets become easy. The functional managers are 

informed about the progress, achievements and shortfalls in the activity and the targets. The 

manager is kept alert by providing certain information indicating and probable trends in the 

various aspects of business. This helps in forecasting and long-term perspective planning. 

The manager’s attention is bought to a situation which is expected in nature, inducing him to 

take an action or a decision in the matter. Disciplined information reporting system creates 

structure database and a knowledge base for all the people in the organization. Role and 

Impact of MIS • The information is available in such a form that it can be used straight away 

by blending and analysis, saving the manager’s valuable time.  
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• The MIS creates another impact in the organization which relates to the understanding of 

the business itself. The MIS begins with the definition of data, entity and its attributes. It uses 

a dictionary of data, entity and attributes, respectively, designed for information generation in 

the organization. Since all the information systems use the dictionary, there is common 

understanding of terms and terminology in the organization bringing clarity in the 

communication and a similar understanding of an event in the organization.  

Role and Impact of MIS • The MIS calls for a systematization of the business operations for 

an effective system design. This leads to streaming of the operations which complicates the 

system design. It improves the administration of the business by bringing a discipline in its 

operations as everybody is required to follow and use systems and procedures. This process 

brings a high degree of professionalism in the business operations. 

 • The goals and objectives of the MIS are the products of business goals and objectives. It 

helps indirectly to pull the entire organization in one direction towards the corporate goals 

and objectives by providing the relevant information to the organization.  A well designed 

system with a focus on the manager makes an impact on the managerial efficiency. The fund 

of information motivates an enlightened manager to use a variety of tools of the management  

• It helps him to resort to such exercises as experimentation and modelling. The use of 

computers enables him to use the tools and techniques which are impossible to use manually. 

The ready-made packages make this task simple. The impact is on the managerial ability to 

perform. It improves decision-making ability considerably high. Since, the MIS work on the 

basic system such as transaction processing and database, the drudgery of the clerical work is 

transferred to the computerized system, relieving the human mind for better work. It will be 

observed that lot of manpower is engaged in this activity in the organization. Seventy (70) 

percent of the time is spent in recording, searching, processing and communicating. This MIS 

has a direct impact on this overhead. It creates information –based working culture in the 

organization.  

MIS and Users 

 • Every person in the Organization is a user of the MIS. The people in the organization 

operate at all levels in the hierarchy. A typical user is a clerk, an assistant, an officer, an 

executive or a manager. Each of them has a specific task and a role play in the management 

of business. The MIS caters to the needs of all persons.  The main task of a clerk is to search 

the data, make a statement and submit it to the higher level. A clerk can use the MIS for a 

quick search and reporting the same to higher level. An assistant has the task of collecting 

and organizing the data, and conducting a rudimentary analysis of it. The MIS offers the user 

tools to perform these tasks. An officer has a role of integrating the data from different 

systems and disciplines to analyse it and make a critical comment if anything adverse is 

found. 

 • In MIS offers the methods and facilities to integrate the data and report the same in a 

proper format. An executive plays the role of a decision maker. He is in a position of 

responsibility and accountability; a position of a planner and a decision maker. He is 

responsible for achieving the targets and goals of the organization. The MIS provides 

facilities to analyse the data and offers the decision support systems to perform the task of 

execution. The MIS provides action-oriented information.  
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MIS and Users • The manager has a position of responsibility and accountability for the 

business results. His management role expands beyond his management function. The MIS 

provides information in a structured or unstructured format for him to react. The MIS caters 

to his constant changing needs of information. The user of the MIS is expected to be a 

rational person and the design of the MIS is based on this assumption. 

 • However, in reality the impact created on individuals by MIS is difficult to explain. The 

recent major technological advances in communication such as Multimedia, Imaging, 

Graphical User Interface (GUI) etc and the ability to access the data stored at different 

locations on the variety hardware of platforms would make MIS more attractive and efficient 

proposition. An intelligent user of information can demonstrate the ability of decision 

making, since his manipulative capability is considerably increased, with the information 

now being available on his desktop. Through the MIS, the information can be used as a 

strategic weapon to counter the threats to business, make businesses more competitive, and 

bring about the organizational transformation through integration. A good MIS also make an 

organization seamless by removing all the communication barriers. MIS as a Control System 

 • MIS AND CONTROL - Information is required at every level either to set up standards, to 

know the actual performance, to compare the results, find out deviations and to take 

corrective action, hence there is a need of a management information system.  It also involves 

interactive control i.e. communicating with the employees directly and hence information 

systems play a significant role. 

 • With the coming of the computer age, management information system [i.e. MIS) is 

becoming popular in the corporate circle for giving quick information to the management. 

The purpose of MIS is reporting and is to provide the necessary information to the managers 

and supervisors at various levels to help them to discharge their functions of organising, 

planning, control and decision making. MIS as a Control System  

• RELATION OF MIS AND BPM  

• Concept of business performance management is based upon management control systems.  

MIS satisfies diversifies diverse needs through a variety of systems such as query analysis, 

modelling system, analysis system and decision support system.  Management as a control 

system  Planning, organizing, staffing, coordinating, directing and controlling are the various 

steps in a management process. All the steps prior to a control are necessary but are not 

necessarily self-assuring the results unless it is followed by strong control mechanism. The 

management experts have viewed these steps as `Management Control System'. They 

postulate the hypothesis that unless a control is exercised on the process, the goals will not be 

achieved. They advocate a system of effective control to ensure the achievement of the 

business objectives. 

 • MIS as a Control System  

• A definition of control is the process through which managers assure that actual activities 

conform to the planned activities, leading to the achievement of the stated common goals. 

The control process measures a progress towards those goals, and enables the manager to 

detect the deviations from the original plan in time to take corrective actions before it is too 

late. Rober J Mockler defines and points out the essential elements of the control process.  

The management is a systematic effort to set the performance standards in line with the 
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performance objectives, to design the information feedback systems, to compare the actual 

performance with these predetermined standards, to identify the deviations from the 

standards, to measure its significance and to take corrective actions in case of significant 

deviations. This systematic effort is undertaken through the management control system.  The 

control system is essential to meet the environmental changes discussed earlier, to meet the 

complexity of today's business, to correct this mistakes made by the people, and to effectively 

monitor the delegation process. A reliable and effective control system has the following 

features. 

 MIS –a support to the Management 

 • The management process is executed through a variety of decisions taken at each step of 

planning, organizing, staffing, directing coordinating and control. If the management is able 

to spell out the decisions required to be taken, the MIS can be designed suitably. The 

decisions required to be taken in these steps are tabulated in Table below.  

• The objective of the MIS is to provide information for a decision support in the process of 

management. It should help in such a way that the business goals are achieved in the most 

efficient manner. Since the decision making is not restricted to a particular level, the MIS is 

expected to support all the levels of the management in conducting the business operations. 

Unless the MIS becomes a management aid, it is not useful to the organization. 

 • Table: Decisions in Management MIS –a support to the Management Steps in Management 

Decision Planning A selection from various alternatives - strategies, resources, methods, etc. 

Organization A selection of a combination out of several combinations of the goals, people, 

resources, method and authority. Staffing Providing a proper manpower complement. 

Directing Choosing a method from the various methods of directing the efforts in the 

organization. Coordinating Choice of the tools and the techniques for coordinating the efforts 

for optimum results. Controlling A selection of the exceptional conditions and the decision 

guidelines MIS –a support to the Management 

 • MIS: Support to Management The management process is executed through different 

decisions taken at each step of management. Steps in Management Planning Organization 

Staffing Directing Coordinating Controlling Decision A selection from various alternatives 

like strategies, resources, methods A selection for goals, people, resources, methods 

Providing manpower Choosing methods from various methods Choice of tools and 

techniques for coordinating efforts A selection of exceptional conditions and he decision 

guidelines  

• Support to Management Environment Management Goal Setting Planning Organizing 

Staffing Directing Coordinating Controlling Information Support MIS Management 

Effectiveness and MIS  

• Essential characteristics of an effective management information system are 

1. MIS is management oriented 

 2. MIS is developed under the direction of management  

3. MIS is an integrated system  
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 4. common data flows  

 5. MIS is based upon future needs of the business 

 6. MIS is composed of sub-systems  

 7. MIS requires flexibility  

8. distributed data processing and  

 9. MIS is mostly computerized. Management Effectiveness and MIS  

 Management Information System is established in an organization to provide relevant 

information to the managers to operate effectively and efficiently.  

1. MIS is management oriented:  

 The design of MIS starts with an appraisal of the information needs of the 

management. The system is usually designed from top to bottom. However, this does 

not mean that MIS fulfils the information needs of top management only.  

 2. MIS is developed under the direction of management: Because of management 

orientation of MIS, it is imperative that, management of an organisation actively 

directs the development and establishment of the MIS in an organisation. It is rare to 

find an MIS where the manager himself, or a high level representative of his 

department, is not spending a good deal of time in the system design. Management 

Effectiveness and MIS  

 3. MIS is an integrated system:  MIS is an integrated system which blends 

information from several operational areas to serve the information needs of the 

management more effectively. It takes a comprehensive view of the interlocking sub-

systems which operate within an organisation.  

 4. Common data flows: MIS seeks to avoid duplication and redundancy in data 

collection, storage and dissemination of information. The designers of MIS are aware 

that a few key source documents account for much of the information flow and affect 

many functional areas. Organization as a System Organizations and their members are 

usefully conceptualized as systems designed to accomplish predetermined goals and 

objectives through people and other resources that they employ. Organizations are 

composed of smaller, interrelated systems (departments, units, divisions, etc.) serving 

specialized functions. Typical functions include accounting, marketing, production, 

data processing, and management. Specialized functions (smaller systems) are 

eventually reintegrated through various ways to form an effective organizational 

whole. 

 • MIS: Organization Effectiveness  A key measure of the effectiveness of an MIS is 

the accuracy and reliability of its information. The accuracy of the data it uses and the 

calculations it applies generally determine the effectiveness of the resulting 

information. However, not all data needs to be equally accurate. MIS: Organization 

Effectiveness • Relevance of Information  

• The information a manager receives from an MIS has to relate to the decisions the 

manager has to make. An effective MIS takes data that originates in the areas of 

activity that concern the manager at any given time, and organizes it into forms that 

are meaningful for making decisions. If a manager has to make pricing decisions, for 
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example, an MIS may take sales data from the past five years, and display sales 

volume and profit projections for various pricing scenarios.  

• Usefulness of Information  The information a manager receives from an MIS may 

be relevant and accurate, but it is only useful if it helps him with the particular 

decisions he has to make. For example, if a manager has to make decisions on which 

employees to cut due to staff reductions, information on resulting cost savings is 

relevant, but information on the performance of the employees in question is more 

useful. The MIS has to make useful information easily accessible. Organization as a 

System 

 • The significance of conceptualizing organizations as complex systems is that 

systems principles allow insight into how organizations work. To ascertain 

information requirements properly and to design appropriate information systems, it is 

of primary importance to understand the organization as a whole. All systems are 

composed of subsystems (which include information systems); therefore, when 

studying an organization, we also examine how smaller systems are involved and how 

they function.  

• Organizations exist and operate in a competitive environment, and can seem 

complex and highly confusing amorphous mess that is very had to comprehend and 

analyse. The notion of "Organization as Systems" refers to an approach to 

conceptualizing organizations as systems based on systems thinking and theory, in 

order to give clarity and perspective to study and analyse the organization. A system 

is defined by its boundaries - the limits that identify its components, processes, and 

interrelationships when it interfaces with another system. Enterprise Resource 

Planning(ERP) - What Is Enterprise Resource Planning (ERP)?  

 Enterprise resource planning (ERP) is a process used by companies to manage and 

integrate the important parts of their businesses. Many ERP software applications are 

important to companies because they help them implement resource planning by 

integrating all of the processes needed to run their companies with a single system. 

An ERP software system can also integrate planning, purchasing inventory, sales, 

marketing, finance, human resources, and more. 

 • Need of ERP  

1) Standardization of Software 

 • With an unmanaged system, various business processes within an organization 

utilize disparate applications to manage similar operations. This can lead to chaotic 

data transfer, time-consuming processes, and security gaps. Need of ERP  

 2) Better Accounting and Financial Reporting  Keeping track of your financials is a 

critical factor in determining your success through a growth phase, but as your 

company grows the complexity of transactions may seem overwhelming without an 

efficient centralized system. 3) Faster Response Times  As you start gaining traction 

in the market and your reputation increases, your ability to improve your service 

delivery could act as a key differentiator from your competition. To deliver better 

customer service, your front-line executives and sales team need maximum access to 

all information across all departments, the systems need to be integrated into one 

centralized unit.  

 4) Regulatory Compliance and Security  Integrated ERP software can help you 

ensure that back-office operations are in sync with the regulatory rules of the 
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manufacturing industry. Most ERP solution providers monitor compliance and 

regulatory changes and keep updating their features to help you meet the new 

requirements. Not only does Enterprise Resource Planning (ERP) software simplify 

data processing and streamline your internal processes, they also enhance your 

security with features like regulated data access and in-built firewall systems. The 

integration of multiple processes into one unified system, also makes it easier for your 

system administrators to control and monitor the security of your software. Need of 

ERP  

 5) Mobility and Flexibility -Through ERP software, data from various departments of 

an organization is streamlined into a unified platform. As modern workplace trends 

like BYOD become more popular, the need for flexibility in enterprise software is an 

essential factor when making software investment choices. ERP solutions today can 

process multiple functions by leveraging a centralized database to provide accurate 

information to any user, anywhere in the world, on any device. Remote access to the 

database and critical numbers saves time and effort, and ensures the delivery of 

quality work within deadlines. As your company grows, you will need to leverage 

technology to maintain control over things and stay ahead of the competition. IFS's 

ERP solution, ranked as a “Leader” in the Gartner Magic Quadrant, can help you 

move on from age-old silos towards the digital transformation you will need for the 

future.  

 ProV is an award-winning and trusted partner for IFS solutions, and provides 

Enterprise Resource Planning (ERP), Enterprise Service Management (ESM), Field 

Service Management (FSM) and Enterprise Operation Intelligence (EOI) services. For 

more details on how to get the most out of your ERP investment, drop a comment 

below or contact us today. Enterprise Resource Planning(ERP)  

 KEY TAKEAWAYS  

ERP software can integrate all of the processes needed to run a company.  

• ERP solutions have evolved over the years, and many are now typically web-based 

applications that users can access remotely.  

• Some benefits of ERP include the free flow of communication between business 

areas, a single source of information, and accurate, real-time data reporting.  

• An ERP system can be ineffective if a company doesn't implement it carefully.  

• Understanding Enterprise Resource Planning  You can think of an enterprise 

resource planning system as the glue that binds together the different computer 

systems for a large organization. Without an ERP application, each department would 

have its system optimized for its specific tasks. With ERP software, each department 

still has its system, but all of the systems can be accessed through one application 

with one interface. History of ERP 

 • Enterprise resource planning (ERP) is the integrated management of main business 

processes, often in real time and mediated by software and technology. ERP is usually 

referred to as a category of business management software—typically a suite of 

integrated applications—that an organization can use to collect, store, manage, and 

interpret data from many business activities. ERP Systems can be local based or 

Cloud-based. Cloud based applications are growing in recent days due to information 

being readily available from any location with internet access. 

 • Benefits of ERP 
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 Enhanced Business Reporting: • Better reporting tools with real-time information • A 

single source of truth – one integrated database for all business processes Benefits of 

ERP • Better customer service: • Better access to customer information • Faster 

response times • Improved on-time delivery • Improved order accuracy ERP 

applications and Emerging trends • #1 CRM is at the top • With various consumer 

based companies performing poorly due to the escalating recession, companies have 

realized the importance of using customer data to their advantage. Hence the leading 

purchases in ERP tend to be for a CRM system.  

#2 Need based ERP purchases • One aspect of ERP which stymied its usage in SMBs 

was that small organizations required only some of the functionalities offered by a 

full-fledged ERP software. Except the core functions, others remained idle, which 

reduced the overall productivity of the purchase. The current trend is need based sales 

of the ERP software. History of ERP • The Gartner Group first used the acronym ERP 

in the 1990s to include the capabilities of material requirements planning (MRP), and 

the later manufacturing resource planning (MRP II), as well as computer-integrated 

manufacturing. Without replacing these terms, ERP came to represent a larger whole 

that reflected the evolution of application integration beyond manufacturing. • Not all 

ERP packages are developed from a manufacturing core; ERP vendors variously 

began assembling their packages with finance-and-accounting, maintenance, and 

human-resource components. By the mid-1990s ERP systems addressed all core 

enterprise functions. Governments and non–profit organizations also began to use 

ERP systems. An "ERP system selection methodology" is a formal process for 

selecting an enterprise resource planning (ERP) system. Existing methodologies. 

Benefits of ERP • Improved Inventory Costs: • Only carry as much inventory as 

needed, avoid these common issues • Too much inventory, and higher overhead costs 

• Too little inventory, and longer customer fulfilment times • Boosted Cash Flow: • 

Better invoicing and better collections tools to bring cash in faster • Faster cash means 

more cash on-hand for the business • Cost Savings: • Improved inventory planning • 

Better procurement management • Better customer service • Improved vendor 

relationship management ERP –A Subset of Enterprise Applications • Enterprise 

software, also known as enterprise application software (EAS), is computer software 

used to satisfy the needs of an organization rather than individual users. Such 

organizations include businesses, schools, interest-based user groups, clubs, charities, 

and governments. Enterprise software is an integral part of a (computer-based) 

information system; a collection of such software is called an enterprise system. 

These systems handle a chunk of operations in an organization with the aim of 

enhancing the business and management reporting tasks. The systems must process 

the information at a relatively high speed and can be deployed across a variety of 

networks. ERP –A Subset of Enterprise Applications • Although the difference 

between ERP and enterprise systems is obvious, many people confuse these two 

notions. Probably, it’s because both terms contain the same word. Enterprise software 

vs ERP Here, what things differ these IT products and what value they are able to add 

to your business. • ERP is an acronym which means enterprise resource planning. 

Here is a concept of ERP: • ES is another common acronym to denote enterprise 

systems. • ERP is typically one application that is a set of modules. This software is 

focused on several back-office functions of a business like finance processing, 
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manufacturing, and inventory control. It relates to the planning resources for the 

enterprise. E-CRM • The eCRM or electronic customer relationship management 

coined by Oscar Gomes encompasses all standard CRM functions with the use of the 

net environment i.e., intranet, extranet and internet. Electronic CRM concerns all 

forms of managing relationships with customers through the use of information 

technology (IT). • Customer relationship management (CRM) is a process in which a 

business or other organization administers its interactions with customers, typically 

using data analysis to study large amounts of information. • From RM to CRM • The 

concept of relationship marketing (RM) was established by marketing professor 

Leonard Berry in 1983. He considered it to consist of attracting, maintaining and 

enhancing customer relationships within organizations. In the years that followed, 

companies were engaging more and more in a meaningful dialogue with individual 

customers. In doing so, new organizational forms as well as technologies were used, 

eventually resulting in what we know as customer relationship management. 

 E-CRM • The main difference between CRM and e-CRM is that the first does not 

acknowledge the use of technology, where the latter uses information technology (IT) 

in implementing RM strategies. • CRM systems compile data from a range of 

different communication channels, including a company's website, telephone, email, 

live chat, marketing materials and more recently, social media. They allow businesses 

to learn more about their target audiences and how to best cater for their needs, thus 

retaining customers and driving sales growth. CRM may be used with past, present or 

potential customers. The concepts, procedures, and rules that a corporation follows 

when communicating with its consumers are referred to as customer relationship 

management (CRM). This complete connection covers direct contact with customers, 

such as sales and service-related operations, forecasting, and the analysis of consumer 

patterns and behaviours, from the perspective of the company. Typical Business 

Touchpoints  

• These touchpoints include advertising, promotions, social media, word of mouth 

among others which allow consumers to interact with the brand before entering the 

store 

 • Traditional brand touchpoints have been utilised for many years such as, ad 

campaigns, media advertising, promotions and events. 

the definition of a touchpoint is:  

• Touchpoint (also touch point, contact point, point of contact) is business jargon for 

any encounter where customers and business engage to exchange information, 

provide service, or handle transactions. Typical Business Touchpoints  

• Company-created touchpoints  Touchpoints allow marketers to deliver brand 

messages, increase consumer's knowledge of the brand and strengthen the company's 

customer-brand relationship, while adding value to the brand or product. When 

planning marketing touchpoints, marketers focus their attention on creating 

touchpoints that are most critical in forming and maintaining consumer relationships 

with the brand. Each company has communication objectives they look to achieve 

through having effective communication with their consumers through persuasion, 

influencing the brand voice and personality, creating a positive feeling towards the 

brand and driving sales. 

 Orbitz  
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• Orbitz.com is a travel fare aggregator website and travel metasearch engine. The 

website is owned by Orbitz Worldwide, Inc., a subsidiary of Expedia Group. It is 

headquartered in the Citigroup Centre, Chicago, Illinois • Orbitz competes in an 

industry that moves at Internet speed, but several years ago, they weren’t making the 

most of cloud technology to work smart and fast. Peggy Bianco, GVP of Global Hotel 

Services, decided it was time to make a change—by putting Salesforce and business 

apps from the AppExchange at the heart of their sales process in order to accelerate 

sales and centralize data. 

 • Maximizing CRM as a tool 

 • One thing VanDyke was faced with in her new role was 250 people using 

Salesforce CRM, but not in the best way. They were managing contacts as if it was a 

spreadsheet only and not doing much more. There was also a huge amount of 

duplicate information. VanDyke took the time to work with different departments to 

get to know what they do specifically and their major pain points, before suggesting a 

fix. • Peer Tip: “Understand what problem you’re trying to solve first. This will help 

you determine the solution,” says Bianco. 
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An e-commerce payment system (or an electronic payment system) facilitates the acceptance 

of electronic payment for online transactions. Also known as a subcomponent of electronic 

data interchange (EDI), e-commerce payment systems have become increasingly popular due 

to the widespread use of the internet-based shopping and banking. Credit cards remain the 

most common forms of payment for e-commerce transactions. As of 2008, in North America 

almost 90% of online retail transactions were made with this payment type. 

It is difficult for an online retailer to operate without supporting credit and debit cards due to 

their widespread use. 

Online merchants must comply with stringent rules stipulated by the credit and debit card 

issuers (e.g. Visa and Mastercard) in accordance with bank and financial regulation in the 

countries where the debit/credit service conducts business. 

For the vast majority of payment systems accessible on the public Internet, baseline 

authentication (of the financial institution on the receiving end), data integrity, and 

confidentiality of the electronic information exchanged over the public network involves 

obtaining a certificate from an authorized certificate authority (CA) who provides public-key 

infrastructure (PKI). 

Even with transport layer security (TLS) in place to safeguard the portion of the transaction 

conducted over public networks—especially with payment systems—the customer-facing 

website itself must be coded with great care, so as not to leak credentials and expose 

customers to subsequent identity theft. 

Despite widespread use in North America, there are still many countries such as China and 

India that have some problems to overcome in regard to credit card security. 

Increased security measures include use of the card verification number (CVN) which detects 

fraud by comparing the verification number printed on the signature strip on the back of the 

card with the information on file with the cardholder's issuing bank. 

There are companies that specialize in financial transaction over the Internet, such as Stripe 

for credit cards processing, Smart pay for direct online bank payments and PayPal for 

alternative payment methods at checkout. 

Many of the mediaries permit consumers to establish an account quickly, and to transfer 

funds between their on-line accounts and traditional bank accounts, typically via automated 

clearing house (ACH) transactions. 

The inherent information asymmetry of large financial institutions maintaining information 

safeguards provides the end-user with little insight into the system when the system 

mishandles funds, leaving disgruntled users frequently accusing the mediaries of sloppy or 

wrongful behaviour; trust between the public and the banking corporations is not improved 

when large financial institutions are revealed to have taken flagrant advantage of their 

asymmetric power, such as the 2016 Wells Fargo account fraud scandal.  
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An e-payment system is a way of making transactions or paying for goods and services 

through an electronic medium, without the use of checks or cash. It’s also called an electronic 

payment system or online payment system. 

The electronic payment system has grown increasingly over the last decades due to the 

growing spread of internet-based banking and shopping. 

As the world advances more with technology development, we can see the rise of electronic 

payment systems and payment processing devices. As these increase, improve, and provide 

ever more secure online payment transactions the percentage of check and cash transactions 

will decrease.  

Electronic Payment Methods 

One of the most popular payment forms online are credit and debit cards. Besides them, there 

are also alternative payment methods, such as bank transfers, electronic wallets, smart cards 

or bitcoin wallet (bitcoin is the most popular cryptocurrency). 

E-payment methods could be classified into two areas, credit payment systems and cash 

payment systems. 

1. Credit Payment System 

Credit Card — A form of the e-payment system which requires the use of the card 

issued by a financial institute to the cardholder for making payments online or 

through an electronic device, without the use of cash. 

E-wallet — A form of prepaid account that stores user’s financial data, like debit and 

credit card information to make an online transaction easier. 

Smart card — A plastic card with a microprocessor that can be loaded with funds to 

make transactions; also known as a chip card.  

2. Cash Payment System 

Direct debit — A financial transaction in which the account holder instructs the bank to 

collect a specific amount of money from his account electronically to pay for goods or 

services. 

E-check — A digital version of an old paper check. It’s an electronic transfer of money from 

a bank account, usually checking account, without the use of the paper check. 

E-cash is a form of an electronic payment system, where a certain amount of money is stored 

on a client’s device and made accessible for online transactions. 

Stored-value card — A card with a certain amount of money that can be used to perform the 

transaction in the issuer store. A typical example of stored-value cards are gift cards. 

E- payment system- an overview 

Understanding e-Payment System 

Every one of us, at least once, has indulged in purchasing goods and services online and paid 

for them electronically or through an e-payment mode, where the transaction takes place 

electronically and not through cheques or cash. Sprouting under several names, e-payment or 
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online payment system comes with multiple payment methods like Credit and Debit Cards, 

Net banking or IMPS. 

The evolution and growth of the electronic payment system has sprung in the last decade and 

can be attributed to the developing internet speed and technology which has indefinitely 

pushed the consumers towards online shopping and internet-based banking services thereby, 

reducing the overall usage of cash. 

With the constant rise in the number of consumers preferring to pay via online transfers and 

retailers selling over the internet, eliminating cash payments, will sure propel us into the 

future of globalization, where cash would be a thing of the past. 

How does e-payment system work?  

Electronic payments are instant and therefore convenient, saving a lot of time. How simply, 

with a click of a button, you successfully pay for your favourite dress, or order groceries or 

make an online booking. Even though all of this happens in a span of seconds, the process 

behind this is quite comprehensive. 

Customer Action: The journey of an electronic payment begins with a customer visit a 

merchant’s site, add products or services they want to the cart and clicks on the checkout 

button. Post this, the customer chooses his preferred form of payment option and proceeds 

towards filling in the banking or card details. The customer then, is redirected to the bank’s 

page to proceed with the payment. 

Payment Authentication and Authorization by the Operator: Once the customer proceeds with 

the payment, the payment gateway along with various parties involved, authenticates if the 

payment information entered is valid. Upon entering valid information, a successful 

transaction message is reported back by the payment gateway, informing the customer about 

the payment confirmation on real-time basis. 

Payment Settlement in Merchant’s Account: On fulfilling the transaction, the Online payment 

provider receives payment from the customer’s bank account and transfers the same into the 

Merchants account. 

B2C Payments- 

B2C payments are transactions made by a business to a consumer, which could either be an 

individual or small business. 

One-time payments, like rebates and refunds, come to mind as key examples. 

Paying employees their wages is also a B2C payment, as well as claims disbursements from 

an insurance company to its policy holders or payments from a larger company to an 

individually-owned small business supplier. 

This article discusses how instant payments may be able to improve the payment experience 

for businesses, their customers, employees and suppliers. 

B2B payment- 

The definition of business-to-business payments or B2B payments is the transfer of value 

denominated in currency from buyer to supplier for good or services supplied. 
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B2B payments can be a one time or recurring transaction depending on the contractual 

agreement made between the buyer and supplier. 

B2B payments are more complex than business-to-consumer or B2C payments, since B2B 

payment processing requires more time to approve and settle the transaction which can take 

days or weeks. Whereas in B2C payment processing, the transaction is typically settled on the 

spot. 

Types of E- payment systems 

Credit Card 

The most popular form of payment for e-commerce transactions is through credit cards. 

It is simple to use; the customer has to just enter their credit card number and date of expiry 

in the appropriate area on the seller’s web page. 

To improve the security system, increased security measures, such as the use of a card 

verification number (CVN), have been introduced to on-line credit card payments. 

The CVN system helps detect fraud by comparing the CVN number with the cardholder’s 

information. 

DEBIT CARDS- 

Debit cards are the second largest e-commerce payment medium in India. Customers who 

want to spend online within their financial limits prefer to pay with their Debit cards. With 

the debit card, the customer can only pay for purchased goods with the money that is already 

there in his/her bank account as opposed to the credit card where the amounts that the buyer 

spends are billed to him/her and payments are made at the end of the billing period. 

Digital accumulating balance payment systems are more like utility bills. This system allows 

users to make multiple purchases, which will be totalled up and billed for at the end of a time 

period. This is ideal for micro-transactions heavy websites, where numerous cheap items are 

purchased frequently. The micro-payment system uses a technology similar to the digital 

wallet, where the customer transfers some money into the online stored value system and 

uses it to pay for digital products. 

ONINE STORED VALUE PAYMENT SYSTEM- 

Stored value systems are a form of electronic payment technology. They coexist with credit 

and debit technology and principally target the low value transactions. Online stored value 

systems have very low transaction cost. Stored value systems are based on creating a form of 

electronic value, for example on smart cards or as computer files. The value can be bought 

(withdrawn) anytime and spent in optional parts at a later date. 

DIGITAL CASH- 

Digital cash is a system of purchasing cash credits in relatively small amounts, storing the 

credits in your computer, and then spending them when making electronic purchases over the 

Internet. Theoretically, digital cash could be spent in very small increments, such as tenths of 

a cent (U.S.) or less. Most merchants accepting digital cash so far, however, use it as an 

alternative to other forms of payment for somewhat higher price purchases. There are several 
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commercial approaches to digital cash on the Web. Among these are encash from Digi Cash 

and Cybercast. 

Digital (electronic) cards- 

A digital wallet, also known as e-wallet, is an electronic device, online service, or software 

program that allows one party to make electronic transactions with another party bartering 

digital currency units for goods and services. 

Users might also have their driver's license, health care, loyalty card(s) and other ID 

documents stored within the wallet. 

Money can be deposited in the digital wallet prior to any transactions or, in other cases, an 

individual's bank account can be linked to the digital wallet. 

For example, a digital wallet could verify the age of the buyer to the store while purchasing 

alcohol. 

 

AGILE WALLET- 

How to implement an agile payment system? 

An agile payment system is the best way to deal with the multiple financial transactions made 

by online buyers on online stores or marketplace, and to increase their loyalty. Limonetik 

offers them possibility to efficiently manage the combination of multiple means of payment 

used by the users. 

SMART CARDS- 

A smart card, chip card, or integrated circuit card (ICC or IC card) is a physical electronic 

authorization device, used to control access to a resource. It is typically a plastic credit card-

sized card with an embedded integrated circuit (IC) chip. 

Applications include identification, financial, mobile phones (SIM), public transit, computer 

security, schools, and healthcare. Smart cards may provide strong security authentication for 

single sign-on (SSO) within organizations. 

DIGITAL CHECKS- 

ICICI Bank offers cheque printing facility at your premises or at your branches, based on 

information uploaded through Corporate Internet Banking. 

File can be upload and approved by clients from remote location 

Increased security owing to payment file upload through Corporate Internet Banking. 

PLASTIC MONEY- 

Plastic money refers to the hard plastic cards we use every day in place of actual bank notes. 

For example ATM cards like credit card and debit card are electronic generated card that acts 

as plastic money at the time of buying of goods and services. Debit card is used to withdraw 

money from your bank account at the time of payment for something and credit card is used 

to generate credit in the name of your bank account for the purpose of electronic payment. 
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Secure Electronic Transaction (SET) Protocol 

Secure Electronic Transaction (SET) is a communications protocol standard for securing 

credit card transactions over networks, specifically, the Internet. SET was not itself a 

payment system, but rather a set of security protocols and formats that enabled users to 

employ the existing credit card payment infrastructure on an open network in a secure 

fashion. However, it failed to gain attraction in the market. Visa now promotes the 3-D 

Secure scheme. 
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Microsoft Office, or simply Office, is a family of client software, server software, and 

services developed by Microsoft. • It was first announced by Bill Gates on August 1, 1988, at 

COMDEX in Las Vegas. Initially a marketing term for an office suite (bundled set of 

productivity applications), the first version of Office contained Microsoft Word, Microsoft 

Excel, and Microsoft PowerPoint. 

 • Over the years, Office applications have grown substantially closer with shared features 

such as a common spell checker, OLE data integration and Visual Basic for Applications 

scripting language. 

 • Microsoft also positions Office as a development platform for line-of-business software 

under the Office Business Applications brand.  

• On July 10, 2012, Softpedia reported that Office was being used by over a billion people 

worldwide.  

• Office is produced in several versions targeted towards different end-users and computing 

environments. 

 • The original, and most widely used version, is the desktop version, available for PCs 

running the Windows and macOS operating systems. Microsoft also maintains mobile apps 

for Android and iOS. • Office on the web is a version of the software that runs within a web 

browser MS-Office 

 • Since Office 2013, Microsoft has promoted Office 365 as the primary means of obtaining 

Microsoft Office: it allows the use of the software and other services on a subscription 

business model, and users receive feature updates to the software for the lifetime of the 

subscription, including new features and cloud computing integration that are not necessarily 

included in the "on-premises" releases of Office sold under conventional license terms. 

 • In 2017, revenue from Office 365 overtook conventional license sales.  

• Microsoft also rebranded most of their standard Office 365 editions into Microsoft 365 to 

emphasize their current inclusion of products and services.  

• The current on-premises, desktop version of Office is Office 2019, released on September 

24, 2018. Ms-Word • Microsoft Word is a word processor developed by Microsoft. It was 

first released on October 25, 1983, under the name Multi-Tool Word for Xenix systems 

 • Subsequent versions were later written for several other platforms including IBM PCs 

running DOS (1983), Apple Macintosh running the Classic Mac OS (1985), AT&T UNIX PC 

(1985), Atari ST (1988), OS/2 (1989), Microsoft Windows (1989), SCO Unix (1990), and 

macOS (2001). 

 • Commercial versions of Word are licensed as a standalone product or as a component of 

Microsoft Office 365, or Microsoft 365 Premium subscription, Windows RT or the 

discontinued Microsoft Works suite. Ms-Word  

• In 1981, Microsoft hired Charles Simonyi, the primary developer of Bravo, the first GUI 

word processor, which was developed at Xerox PARC. Simonyi started work on a word 

processor called Multi-Tool Word and soon hired Richard Brodie, a former Xerox intern, 

who became the primary software engineer. 
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 • Microsoft announced Multi-Tool Word for Xenix and MS-DOS in 1983. • Its name was 

soon simplified to Microsoft Word. 

 • Free demonstration copies of the application were bundled with the November 1983 issue 

of PC World, making it the first to be distributed on-disk with a magazine.  

• That year Microsoft demonstrated Word running on Windows Usage of smart art tools • 

Create a SmartArt graphic to quickly and easily make a visual representation of your 

information. You can choose from among many different layouts, to effectively communicate 

your message or ideas. SmartArt graphics can be created in Excel, Outlook, PowerPoint, and 

Word, and they can be used throughout Office. • For an overview of SmartArt graphics, 

including considerations for choosing the best graphic and layout type to display your data or 

convey a concept Usage of smart art tools • Insert a SmartArt graphic and add text to it  

• On the Insert tab, in the Illustrations group, click SmartArt. 

 • In the Choose a SmartArt Graphic dialog box, click the type and layout that you want. • 

Enter your text by doing one of the following: 

 • Click [Text] in the Text pane, and then type your text.  Copy text from another location or 

program, click [Text] in the Text pane, and then paste your text. 

 • Notes: • If the Text pane is not visible, click the arrow control on the left side of the 

SmartArt graphic. • To add text, like a title, in an arbitrary position close to or on top of your 

SmartArt graphic, on the Insert tab, in the Text group, click Text Box to insert a text box. If 

you want only the text in your text box to appear, right-click your text box, click Format 

Shape or Format Text Box, and then set the text box to have no background colour and no 

border.  

• Click in a box in the SmartArt graphic, and then type your text. For best results, use this 

option after you add all of the boxes that you want. Usage of smart art tools • Apply a 

SmartArt Style to a SmartArt graphic  

• A SmartArt Style is a combination of various effects, such as line style, bevel, or 3-D, that 

you can apply to the shapes in your SmartArt graphic to create a unique and professionally 

designed look. 

 • Click your SmartArt graphic. 

 • Under SmartArt Tools, on the Design tab, in the SmartArt Styles group, click the SmartArt 

Style that you want. 

 • To see more SmartArt Styles, click the More button .  

• Tips • To resize your entire SmartArt graphic, click the border of your SmartArt graphic, 

and then drag the sizing handles in or out until your SmartArt graphic is the size that you 

want. :Usage of smart art tools  

• Add or delete shapes in your SmartArt graphic  

• Click the SmartArt graphic that you want to add another shape to.  
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• Click the existing shape that is located closest to where you want to add the new shape. • 

Under SmartArt Tools, on the Design tab, in the Create Graphic group, click the arrow next 

to Add Shape. 

 • If you don't see the SmartArt Tools or Design tabs, make sure that you've selected the 

SmartArt graphic. You may have to double-click the SmartArt graphic to open the Design 

tab. • Do one of the following: • To insert a shape after the selected shape, click Add Shape 

After.  

• To insert a shape before the selected shape, click Add Shape Before. 

 • Notes: • To add a shape from the Text pane, click an existing shape, move your cursor 

before or after the text where you want to add the shape, and then press ENTER.  

• To delete a shape from your SmartArt graphic, click the shape you want to delete, and then 

press DELETE. To delete your entire SmartArt graphic, click the border of your SmartArt 

graphic, and then press DELETE.  

• To add a shape like a callout or a line, see Add shapes. Usage of smart art tools • Change 

the colours of an entire SmartArt graphic • You can apply colour variations that are derived 

from the theme colours to the shapes in your SmartArt graphic.  

• Click your SmartArt graphic. 

 • Under SmartArt Tools, on the Design tab, in the SmartArt Styles group, click Change 

Colours.  

• If you don't see the SmartArt Tools or Design tabs, make sure that you've selected a 

SmartArt graphic. You may have to double-click the SmartArt graphic to open the Design 

tab. • Click the colour variation that you want. Bookmark 

 • A bookmark in Word works like a bookmark you might place in a book: it marks a place 

that you want to find again easily. You can enter as many bookmarks as you want in your 

document or Outlook message, and you can give each one a unique name so they’re easy to 

identify. 

 • To add a bookmark, you first mark the bookmark location in your document. After that, 

you can jump to the location or add links to it within your document or Outlook message. 

You can also delete bookmarks from a document or Outlook message.  

• Bookmark the location • Select text, a picture, or a place in your document where you want 

to insert a bookmark. • Click Insert > Bookmark 

. • Under Bookmark name, type a name and click Add.  

\• Note: Bookmark names need to begin with a letter. They can include both numbers and 

letters, but not spaces. If you need to separate words, you can use an underscore ( _ )—for 

example, First heading. bookmark • Go to the bookmarked location  

• After creating your bookmarks, you can add links to them within your document or jump to 

them at any time. • Jump to a bookmark  
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• Type CTRL to open the Go To tab in the Find and Replace box. Under Go to what, click 

Bookmark. Enter or select the bookmark name, and then click Go To.  

• Link to a bookmark • You can also add hyperlinks that will take you to a bookmarked 

location in the same document. • Select the text or object you want to use as a hyperlink.  

• Right-click and then click Hyperlink . • Under Link to, click Place in This Document. • In 

the list, select the heading or bookmark that you want to link to.  

• Note: To customize the Screen Tip that appears when you rest the pointer over the 

hyperlink, click ScreenTip, and then type the text that you want. • Click OK. • If you’re 

having any issues or problems with bookmarks, read about the various techniques to 

troubleshoot bookmarks. bookmark  

• Delete a bookmark • Click Insert > Bookmark. • Click either Name or Location to sort the 

list of bookmarks in the document. 

 • Click the name of the bookmark you want to delete, and then click Delete. 

 • If you have inserted a hyperlink to the deleted bookmark, right-click the linked text and 

then click Remove Hyperlink. 

 • Note: To delete both the bookmark and the bookmarked item (such as a block of text or 

other element), select the item, and then press Delete. cross-reference  

• A cross-reference allows you to link to other parts of the same document. For example, you 

might use a cross-reference to link to a chart or graphic that appears elsewhere in the 

document. The cross-reference appears as a link that takes the reader to the referenced item.  

• If you want to link to a separate document you can create a hyperlink. 

\ • Create the item you're cross-referencing first • You can't cross-reference something that 

doesn't exist, so be sure to create the chart, heading, page number, etc., before you try to link 

to it. When you insert the cross-reference, you'll see a dialog box that lists everything that's 

available to link to. Here's an example. cross-reference • Insert the cross-reference 

 • In the document, type the text that begins the cross-reference. On the Insert tab, click 

Cross-reference. • In the Reference type box, click the drop-down list to pick what you want 

to link to. The list of what's available depends on the type of item (heading, page number, 

etc.) you're linking to.  

• In the Insert reference to box, click the information you want inserted in the document. 

Choices depend on what you chose in step 3. 

 • In the For which box, click the specific item you want to refer to, such as "Insert the cross-

reference." • To allow users to jump to the referenced item, select the Insert as hyperlink 

check box. • If they Include above/below check box is available, check it to include specify 

the relative position of the referenced item.• Click Insert. cross-reference 

 • Cross-references are inserted as fields  

• Cross-references are inserted into your document as fields. A field is a set of information 

that instructs Word to insert text, graphics, page numbers, and other material into a document 
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automatically. For example, the DATE field inserts the current date. The advantage of using 

fields is that the content being inserted--date, page number, graphics, etc.--gets updated for 

you whenever there's a change. For example, if you're writing a document over a period of 

days, the date will change each day when you open and save the document. Similarly, if you 

update a graphic that's stored elsewhere but referenced in the field, the update will get picked 

up automatically without you having to re-insert the graphic.  

• If you've inserted a cross-reference and it looks similar to {REF _Ref249586 \* 

MERGEFORMAT}, then Word is displaying field codes instead of field results. When you 

print the document or hide field codes, the field results replace the field codes. To see the 

field results instead of field codes, press ALT+F9, or right-click the field code, and then click 

Toggle Field Codes on the shortcut menu. cross-reference  

• Use a master document 

 • If you want to cross-reference items that reside in a separate document but don't want to 

use hyperlinks, you'll have to first combine the documents into one master document and then 

insert the cross-references. A master document is a container for a set of separate files (or 

subdocuments). You can use a master document to set up and manage a multi-part document, 

such as a book with several chapters. Hyperlink 

 • Create or edit a hyperlink  The fastest way to create a basic hyperlink in an Office 

document is to press ENTER or the SPACEBAR after you type the address of an existing 

webpage, such as http://www.contoso.com. Office automatically converts the address into a 

link. • In addition to webpages, you can create links to existing or new files on your 

computer, to email addresses, and to specific locations in a document. You can also edit the 

address, display text, and font style or colour of a hyperlink.  

• Notes: • If you want to remove links or stop Office from automatically adding hyperlinks, 

see Remove or turn off hyperlinks. 

 

 • This article applies to desktop versions of Word, Excel, Outlook, and PowerPoint. A 

simplified set of hyperlink features is offered in Office Online. If you have a desktop version 

of Office, you can edit your document there for more advanced hyperlink features, or you can 

try or buy the latest version of Office. mail merge utility • How to Use Mail Merge in 

Microsoft Word  

• Mail Merge is most often used to print or email form letters to multiple recipients. Using 

Mail Merge, you can easily customize form letters for individual recipients. Mail merge is 

also used to create envelopes or labels in bulk. • This feature works the same in all modern 

versions of Microsoft Word: 2010, 2013, and 2016. • In a blank Microsoft Word document, 

click on the Mailings tab, and in the Start Mail Merge group, click Start Mail Merge.  

• Click Step-by-Step Mail Merge Wizard. • Select your document type. In this we will select 

Letters. Click Next: Starting document. mail merge utility  

• Select the starting document. In this demo we will use the current (blank) document. Select 

Use the current document and then click Next: Select recipients. 
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 • Note that selecting Start from existing document (which we are not doing in this demo) 

changes the view and gives you the option to choose your document. After you choose it, the 

Mail Merge Wizard reverts to Use the current document.  

• Select recipients. In this demo we will create a new list, so select Type a new list and then 

click Create • Create a list by adding data in the New Address List dialog box and clicking 

OK 

 • Save the list. • Note that now that a list has been created, the Mail Merge Wizard reverts to 

Use an existing list and you have the option to edit the recipient list. mail merge utility • 

Selecting Edit recipient list opens up the Mail Merge Recipients dialog box, where you can 

edit the list and select or unselect records. Click OK to accept the list as is.  

• Click Next: Write your letter • Write the letter and add custom fields. Click Address block 

to add the recipients' addresses at the top of the document • In the Insert Address Block 

dialog box, check or uncheck boxes and select options on the left until the address appears 

the way you want it to.  

• Note that you can use Match Fields to correct any problems. Clicking Match Fields opens 

up the Match Fields dialog box, in which you can associate the fields from your list with the 

fields required by the wizard. 

 • Press Enter on your keyboard and click Greeting line... to enter a greeting. mail merge 

utility • In the Insert Greeting Line dialog box, choose the greeting line format by clicking the 

drop-down arrows and selecting the options of your choice, and then click OK 

 • Note that the address block and greeting line are surrounded by chevrons (« »). Write a 

short letter and click Next: Preview your letters. • Preview your letter and click Next: 

Complete the merge. • Click Print to print your letters or Edit individual letters to further 

personalize some or all of the letters. converting word as PDF files  

• Save a PDF of your file on your mobile device • You can use the Print option to save your 

Word documents, Excel workbooks, and PowerPoint presentations as PDF files. • Open the 

file that you want to save as a PDF, and then tap File on your tablet or tap the File icon on 

your phone. • On the File tab, tap Print.  

• If not already selected, tap Save as PDF on the drop-down list, and then tap Save. 

 • Tap Save. • Choose a location for your PDF, enter a new name (optional), and then tap 

Save. Ms-Excel  

• Microsoft Excel is a spreadsheet developed by Microsoft for Windows, macOS, Android 

and iOS. It features calculation, graphing tools, pivot tables, and a macro programming 

language called Visual Basic for Applications (VBA). It has been a very widely applied 

spreadsheet for these platforms, especially since version 5 in 1993, and it has replaced Lotus 

1-2-3 as the industry standard for spreadsheets. Excel forms part of the Microsoft Office suite 

of software. Ms-Excel: Manipulating data • Excel Data Manipulation Tips & Techniques for 

HMIS 

 • Database conversions are not a “flip of the switch” process and require some work to get 

the data from the source database into the target database.  
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• This walkthrough will outline tips and techniques used in Microsoft Excel to prepare data 

for loading into a target database or for performing offline data cleansing. • General Rules • 

Save your work in versions so you can revert back if necessary  

• Any new data added to the system post-export may have to be re-cleansed so you might 

want to freeze your database • Work with the Excel file only in a secured and control 

environment • Excel does have its limitations. 65536 rows to be exact  

• Audit your work. Working with charts  

• Create a chart (graph) that is recommended for your data, almost as fast as using the chart 

wizard that is no longer available. • Create a chart • Select the data for which you want to 

create a chart. • Click INSERT > Recommended Charts. • On the Recommended Charts tab, 

scroll through the list of charts that Excel recommends for your data, and click any chart to 

see how your data will look. • If you don’t see a chart you like, click All Charts to see all the 

available chart types.  

• When you find the chart you like, click it > OK.  

• Use the Chart Elements, Chart Styles, and Chart Filters buttons, next to the upper-right 

corner of the chart to add chart elements like axis titles or data labels, customize the look of 

your chart, or change the data that is shown in the chart.  

• To access additional design and formatting features, click anywhere in the chart to add the 

CHART TOOLS to the ribbon, and then click the options you want on the DESIGN and 

FORMAT tabs. Working with PIVOT table • A PivotTable is a powerful tool to calculate, 

summarize, and analyse data that lets you see comparisons, patterns, and trends in your data. 

 • PivotTables work a little bit differently depending on what platform you are using to run 

Excel.  

• Create a PivotTable in Excel for Windows • Select the cells you want to create a PivotTable 

from. 

 • Note: Your data shouldn't have any empty rows or columns. It must have only a single-row 

heading. • Select Insert > PivotTable.  

• Under Choose the data that you want to analyse, select Select a table or range. Working 

with PIVOT table  

• In Table/Range, verify the cell range. 

 • Under Choose where you want the PivotTable report to be placed, select New worksheet to 

place the PivotTable in a new worksheet or Existing worksheet and then select the location 

you want the PivotTable to appear. • Select OK.  

• Building out your PivotTable • To add a field to your PivotTable, select the field name 

checkbox in the PivotTables Fields pane. 

 • Note: Selected fields are added to their default areas: non-numeric fields are added to 

Rows, date and time hierarchies are added to Columns, and numeric fields are added to 

Values. • To move a field from one area to another, drag the field to the target area. what-if 
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analysis • By using What-If Analysis tools in Excel, you can use several different sets of 

values in one or more formulas to explore all the various results.  

• For example, you can do What-If Analysis to build two budgets that each assumes a certain 

level of revenue. Or, you can specify a result that you want a formula to produce, and then 

determine what sets of values will produce that result. Excel provides several different tools 

to help you perform the type of analysis that fits your needs. Advanced excel functions-

VLOOKUP()  

• Tip: Try using the new XLOOKUP function, an improved version of VLOOKUP that 

works in any direction and returns exact matches by default, making it easier and more 

convenient to use than its predecessor. • Use VLOOKUP when you need to find things in a 

table or a range by row. For example, look up a price of an automotive part by the part 

number, or find an employee name based on their employee ID. 

 • In its simplest form, the VLOOKUP function says: • =VLOOKUP(What you want to look 

up, where you want to look for it, the column number in the range containing the value to 

return, return an Approximate or Exact match – indicated as 1/TRUE, or 0/FALSE).  

• Tip: The secret to VLOOKUP is to organize your data so that the value you look up (Fruit) 

is to the left of the return value (Amount) you want to find. Advanced excel functions-

VLOOKUP() • How to get started • There are four pieces of information that you will need in 

order to build the VLOOKUP syntax: • The value you want to look up, also called the lookup 

value.  

• The range where the lookup value is located. Remember that the lookup value should 

always be in the first column in the range for VLOOKUP to work correctly. For example, if 

your lookup value is in cell C2 then your range should start with C. 

 • The column number in the range that contains the return value. For example, if you specify 

B2:D11 as the range, you should count B as the first column, C as the second, and so on. 

 • Optionally, you can specify TRUE if you want an approximate match or FALSE if you 

want an exact match of the return value. If you don't specify anything, the default value will 

always be TRUE or approximate match. • Now put all of the above together as follows:  

• =VLOOKUP(lookup value, range containing the lookup value, the column number in the 

range containing the return value, Approximate match (TRUE) or Exact match (FALSE)).  

• Examples hlookup() • Searches for a value in the top row of a table or an array of values, 

and then returns a value in the same column from a row you specify in the table or array. Use 

HLOOKUP when your comparison values are located in a row across the top of a table of 

data, and you want to look down a specified number of rows. Use VLOOKUP when your 

comparison values are located in a column to the left of the data you want to find. • The H in 

HLOOKUP stands for "Horizontal." • Syntax • HLOOKUP(lookup value, table array, 

row_index_num, [range lookup]) 

 • The HLOOKUP function syntax has the following arguments:  
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• Lookup value Required. The value to be found in the first row of the table. Lookup value 

can be a value, a reference, or a text string. • Table array Required. A table of information in 

which data is looked up. Use a reference to a range or a range name.  

• The values in the first row of table array can be text, numbers, or logical values.  

• If range lookup is TRUE, the values in the first row of table array must be placed in 

ascending order: ...-2, -1, 0, 1, 2,... , A-Z, FALSE, TRUE; otherwise, HLOOKUP may not 

give the correct value. If range lookup is FALSE, table array does not need to be sorted. 

hlookup()  

• Uppercase and lowercase text are equivalent. 

 • Sort the values in ascending order, left to right. For more information, see Sort data in a 

range or table . • Row_index_num Required. The row number in table array from which the 

matching value will be returned. A row_index_num of 1 returns the first row value in table 

array, a row_index_num of 2 returns the second row value in table array, and so on. If 

row_index_num is less than 1, HLOOKUP returns the #VALUE! error value; if 

row_index_num is greater than the number of rows on table array, HLOOKUP returns the 

#REF! error value 

 • Range lookup Optional. A logical value that specifies whether you want HLOOKUP to 

find an exact match or an approximate match. If TRUE or omitted, an approximate match is 

returned. In other words, if an exact match is not found, the next largest value that is less than 

lookup value is returned. If FALSE, HLOOKUP will find an exact match. If one is not found, 

the error value #N/A is returned. • Remark • If HLOOKUP can't find lookup value, and range 

lookup is TRUE, it uses the largest value that is less than lookup value. 

 • If lookup value is smaller than the smallest value in the first row of table array, HLOOKUP 

returns the #N/A error value.  

• If range lookup is FALSE and lookup value is text, you can use the wildcard characters, 

question mark (?) and asterisk (*), in lookup value. A question mark matches any single 

character; an asterisk matches any sequence of characters. If you want to find an actual 

question mark or asterisk, type a tilde (~) before the character. pv() 

 • PV, one of the financial functions, calculates the present value of a loan or an investment, 

based on a constant interest rate. You can use PV with either periodic, constant payments 

(such as a mortgage or other loan), or a future value that's your investment goal.  

• Use the Excel Formula Coach to find the present value (loan amount) you can afford, based 

on a set monthly payment. At the same time, you'll learn how to use the PV function in a 

formula.  

• Or, use the Excel Formula Coach to find the present value of your financial investment 

goal. pv() 

 • Syntax • PV(rate, nper, pmt, [fv], [type]) • The PV function syntax has the following 

arguments:  

• Rate Required. The interest rate per period. For example, if you obtain an automobile loan 

at a 10 percent annual interest rate and make monthly payments, your interest rate per month 
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is 10%/12, or 0.83%. You would enter 10%/12, or 0.83%, or 0.0083, into the formula as the 

rate. 

 • Nper Required. The total number of payment periods in an annuity. For example, if you get 

a four-year car loan and make monthly payments, your loan has 4*12 (or 48) periods. You 

would enter 48 into the formula for nper.  

• Pmt Required. The payment made each period and cannot change over the life of the 

annuity. Typically, pmt includes principal and interest but no other fees or taxes. For 

example, the monthly payments on a $10,000, four-year car loan at 12 percent are $263.33. 

You would enter -263.33 into the formula as the pmt. If pmt is omitted, you must include the 

fv argument. • Fv Optional. The future value, or a cash balance you want to attain after the 

last payment is made. If fv is omitted, it is assumed to be 0 (the future value of a loan, for 

example, is 0). For example, if you want to save $50,000 to pay for a special project in 18 

years, then $50,000 is the future value. You could then make a conservative guess at an 

interest rate and determine how much you must save each month. If fv is omitted, you must 

include the pmt argument.  

• Type Optional. The number 0 or 1 and indicates when payments are due. fv() 

 • FV, one of the financial functions, calculates the future value of an investment based on a 

constant interest rate. You can use FV with either periodic, constant payments, or a single 

lump sum payment. • Use the Excel Formula Coach to find the future value of a series of 

payments. At the same time, you'll learn how to use the FV function in a formula. 

 • Or, use the Excel Formula Coach to find the future value of a single, lump sum payment. 

fv()  

• Syntax • FV(rate,nper,pmt,[pv],[type]) • For a more complete description of the arguments 

in FV and for more information on annuity functions, see PV.  

• The FV function syntax has the following arguments: • Rate Required. The interest rate per 

period. • Nper Required. The total number of payment periods in an annuity.  

• Pmt Required. The payment made each period; it cannot change over the life of the annuity. 

Typically, pmt contains principal and interest but no other fees or taxes. If pmt is omitted, 

you must include the pv argument. 

 • Pv Optional. The present value, or the lump-sum amount that a series of future payments is 

worth right now. If pv is omitted, it is assumed to be 0 (zero), and you must include the pmt 

argument.  

• Type Optional. The number 0 or 1 and indicates when payments are due. If type is omitted, 

it is assumed to be 0. schedule()  

• Returns the future value of an initial principal after applying a series of compound interest 

rates. Use FVSCHEDULE to calculate the future value of an investment with a variable or 

adjustable rate.  

• Syntax • FVSCHEDULE(principal, schedule) 
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 • The FVSCHEDULE function syntax has the following arguments: • Principal Required. 

The present value. • Schedule Required. An array of interest rates to apply.  

• Remarks • The values in schedule can be numbers or blank cells; any other value produces 

the #VALUE! error value for FVSCHEDULE. Blank cells are taken as zeros (no interest). 

goal seek() • Goal Seek is a built-in Excel tool that allows you to see how one data item in a 

formula impacts another. You might look at these as “cause and effect” scenarios. It’s useful 

to answer “what if” type questions because you can adjust one cell entry to see how the 

results change. The tool is often used in finance, sales, and forecasting scenarios, but there 

are other uses.  

• Needs approval from 2/3 of the voters  

• In our example, the YES votes are a majority but shy of the required 2/3 approval to win the 

election. People quickly realize they were close, but which item do they change to find out 

how close. What would’ve made a difference?  

• Using Goal Seek, we can change the value of one variable and see how the results change. 

This would allow you to answer these types of questions. • How many more YES votes were 

needed to win the election?  

• If 500 more people voted, could the YES team have won? • In each of these questions, the 

goal is to change one data value to see if the YES percentage went over that two-thirds mark 

or 67%. Then, rather than haphazardly changing cell values to see the results, Goal Seek can 

find the answers. goal seek() • How to Use Excel Goal Seek • Time needed: 5 minutes. • 

Create a spreadsheet in Excel that has your data. In the example below, the green cells have 

formulas to calculate the percentage and sum totals. Pin • Click the cell you want to change. 

This is called the “Set cell.” In my example, this will be D4. • From the Data tab, select the 

What if Analysis… button. 

 • Select Goal seek… from the drop-down menu.  

• In the Goal Seek dialog, enter the new “what if” amount in the To value: text box. Pin In 

this example, we’re asking Excel to replace the contents of cell D4, which is 0.64 with 0.67. 

This is the percentage needed to win the election. Technically, we need 66.7% to win, but 

since Goal Seek has an approximation algorithm, I don’t want to run the risk of Excel 

rounding down.  

• We also need to tell Excel which cell to change. Since we wanted to know the number of 

YES votes, we’ll click C4.Pin • Click OK. Excel will overwrite the previous cell value with 

the new one. Pin  

• If you wish to accept the new value, click OK confidence() • Returns the confidence interval 

for a population mean, using a normal distribution. • The confidence interval is a range of 

values. • Your sample mean, x, is at the centre of this range and the range is x ± 

CONFIDENCE. 

 • For example, if x is the sample mean of delivery times for products ordered through the 

mail, x ± CONFIDENCE is a range of population means. • For any population mean, μ0, in 

this range, the probability of obtaining a sample mean further from μ0 than x is greater than 
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alpha; for any population mean, μ0, not in this range, the probability of obtaining a sample 

mean further from μ0 than x is less than alpha. 

 • In other words, assume that we use x, standard, and size to construct a two-tailed test at 

significance level alpha of the hypothesis that the population mean is μ0. • Then we will not 

reject that hypothesis if μ0 is in the confidence interval and will reject that hypothesis if μ0 is 

not in the confidence interval. • The confidence interval does not allow us to infer that there 

is probability 1 – alpha that our next package will take a delivery time that is in the 

confidence interval. confidence()  

• Important: This function has been replaced with one or more new functions that may 

provide improved accuracy and whose names better reflect their usage.  

• Although this function is still available for backward compatibility, you should consider 

using the new functions from now on, because this function may not be available in future 

versions of Excel.  

• For more information about the new functions, see CONFIDENCE.NORM function and 

CONFIDENCE.T function. confidence() • Syntax • CONFIDENCE(alpha,standard_dev,size) 

 • The CONFIDENCE function syntax has the following arguments: • Alpha Required. The 

significance level used to compute the confidence level. The confidence level equals 100*(1 - 

alpha)%, or in other words, an alpha of 0.05 indicates a 95 percent confidence level.  

• Standard Required. The population standard deviation for the data range and is assumed to 

be known. • Size Required. The sample size. • Remarks • If any argument is non-numeric, 

CONFIDENCE returns the #VALUE! error value. • If Alpha is ≤ 0 or ≥ 1, CONFIDENCE 

returns the #NUM! error value. • If Standard ≤ 0, CONFIDENCE returns the #NUM! error 

value.  

• If Size is not an integer, it is truncated. • If Size < 1, CONFIDENCE returns the #NUM! 

error value. 

 • If we assume Alpha equals 0.05, we need to calculate the area under the standard normal 

curve that equals (1 - alpha), or 95 percent. This value is ± 1.96. The confidence interval is 

therefore: AVERAGE() • Returns the average (arithmetic mean) of the arguments. For 

example, if the range A1:A20 contains numbers, the formula =AVERAGE(A1:A20) returns 

the average of those numbers. 

 • Syntax • AVERAGE(number1, [number2], ...) 

 • The AVERAGE function syntax has the following arguments:  

• Number1 Required. The first number, cell reference, or range for which you want the 

average.  

• Number2, ... Optional. Additional numbers, cell references or ranges for which you want 

the average, up to a maximum of 255. AVERAGE() • Remarks 

 • Arguments can either be numbers or names, ranges, or cell references that contain 

numbers. • Logical values and text representations of numbers that you type directly into the 

list of arguments are not counted. • If a range or cell reference argument contains text, logical 
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values, or empty cells, those values are ignored; however, cells with the value zero are 

included. 

 • Arguments that are error values or text that cannot be translated into numbers cause errors. 

• If you want to include logical values and text representations of numbers in a reference as 

part of the calculation, use the AVERAGEA function.  

• If you want to calculate the average of only the values that meet certain criteria, use the 

AVERAGEIF function or the AVERAGEIFS function. AVERAGE()  

• Note: The AVERAGE function measures central tendency, which is the location of the 

centre of a group of numbers in a statistical distribution. The three most common measures of 

central tendency are: • Average, which is the arithmetic mean, and is calculated by adding a 

group of numbers and then dividing by the count of those numbers. For example, the average 

of 2, 3, 3, 5, 7, and 10 is 30 divided by 6, which is 5.  

• Median, which is the middle number of a group of numbers; that is, half the numbers have 

values that are greater than the median, and half the numbers have values that are less than 

the median. For example, the median of 2, 3, 3, 5, 7, and 10 is 4. • Mode, which is the most 

frequently occurring number in a group of numbers. For example, the mode of 2, 3, 3, 5, 7, 

and 10 is 3. AVERAGE() • For a symmetrical distribution of a group of numbers, these three 

measures of central tendency are all the same. For a skewed distribution of a group of 

numbers, they can be different. • Tip: When you average cells, keep in mind the difference 

between empty cells and those containing the value zero, especially if you have cleared the 

Show a zero in cells that have a zero value check box in the Excel Options dialog box in the 

Excel desktop application. When this option is selected, empty cells are not counted, but zero 

values are. • To locate the Show a zero in cells that have a zero value check box: • On the File 

tab, click Options, and then, in the Advanced category, look under Display options for this 

worksheet. average() • Calculates the average (arithmetic mean) of the values in the list of 

arguments.  

• Syntax • AVERAGEA(value1, [value2], ...) • The AVERAGEA function syntax has the 

following arguments: 

 • Value1, value2, ... Value1 is required, subsequent values are optional. 1 to 255 cells, ranges 

of cells, or values for which you want the average. average if() • Returns the average 

(arithmetic mean) of all the cells in a range that meet a given criteria. 

 • Syntax • AVERAGEIF(range, criteria, [average range]) • The AVERAGEIF function 

syntax has the following arguments: • Range Required. One or more cells to average, 

including numbers or names, arrays, or references that contain numbers. • Criteria Required. 

The criteria in the form of a number, expression, cell reference, or text that defines which 

cells are averaged. For example, criteria can be expressed as 32, "32", ">32", "apples", or B4.  

• Average range Optional. The actual set of cells to average. If omitted, range is used. 

averages() • Returns the average (arithmetic mean) of all cells that meet multiple criteria. • 

Syntax • AVERAGEIFS(average range, criteria_range1, criteria1, [criteria_range2, criteria2], 

...) • The AVERAGEIFS function syntax has the following arguments:  
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• Average range Required. One or more cells to average, including numbers or names, arrays, 

or references that contain numbers. • Criteria_range1, criteria_range2, … Criteria_range1 is 

required, subsequent criteria ranges are optional. 1 to 127 ranges in which to evaluate the 

associated criteria. • Criteria1, criteria2, ... Criteria1 is required, subsequent criteria are 

optional. 1 to 127 criteria in the form of a number, expression, cell reference, or text that 

define which cells will be averaged. For example, criteria can be expressed as 32, "32", 

">32", "apples", or B4. MIN() • Returns the smallest number in a set of values.  

• Syntax • MIN(number1, [number2], ...) 

 • The MIN function syntax has the following arguments: • Number1, number2, ... Number1 

is optional, subsequent numbers are optional. 1 to 255 numbers for which you want to find 

the minimum value. MAX() • Returns the largest value in a set of values. • Syntax • 

MAX(number1, [number2], ...)  

• The MAX function syntax has the following arguments: • Number1, number2, ... Number1 

is required, subsequent numbers are optional. 1 to 255 numbers for which you want to find 

the maximum value. COUNT() • The COUNT function counts the number of cells that 

contain numbers, and counts numbers within the list of arguments. Use the COUNT function 

to get the number of entries in a number field that is in a range or array of numbers. For 

example, you can enter the following formula to count the numbers in the range A1:A20: 

=COUNT(A1:A20). In this example, if five of the cells in the range contain numbers, the 

result is 5.  

• Syntax • COUNT(value1, [value2], ...)  The COUNT function syntax has the following 

arguments:  

• value1 Required. The first item, cell reference, or range within which you want to count 

numbers. • value2, ... Optional. Up to 255 additional items, cell references, or ranges within 

which you want to count numbers. • Note: The arguments can contain or refer to a variety of 

different types of data, but only numbers are counted. COUNTA()  

• The COUNTA function counts the number of cells that are not empty in a range. • Syntax • 

COUNTA(value1, [value2], ...)  

• The COUNTA function syntax has the following arguments: • value1 Required. The first 

argument representing the values that you want to count. • value2, ... Optional. Additional 

arguments representing the values that you want to count, up to a maximum of 255 

arguments. count if() • Use COUNTIF, one of the statistical functions, to count the number of 

cells that meet a criterion; for example, to count the number of times a particular city appears 

in a customer list. • In its simplest form, COUNTIF says: • =COUNTIF(Where do you want 

to look?, What do you want to look for?) • For example: • =COUNTIF(A2:A5,"London")  

• =COUNTIF(A2:A5,A4) countifs() • The COUNTIFS function applies criteria to cells 

across multiple ranges and counts the number of times all criteria are met. • 

COUNTIFS(criteria_range1, criteria1, [criteria_range2, criteria2]…) 

 • The COUNTIFS function syntax has the following arguments: • criteria_range1 Required. 

The first range in which to evaluate the associated criteria. • criteria1 Required. The criteria 

in the form of a number, expression, cell reference, or text that define which cells will be 
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counted. For example, criteria can be expressed as 32, ">32", B4, "apples", or "32". • 

criteria_range2, criteria2, ... Optional. Additional ranges and their associated criteria. Up to 

127 range/criteria pairs are allowed.  

• Important: Each additional range must have the same number of rows and columns as the 

criteria_range1 argument. The ranges do not have to be adjacent to each other. ROUND()  

• The ROUND function rounds a number to a specified number of digits. For example, if cell 

A1 contains 23.7825, and you want to round that value to two decimal places, you can use the 

following formula: • =ROUND(A1, 2) • The result of this function is 23.78. • Syntax • 

ROUND(number, num_digits) • The ROUND function syntax has the following arguments: • 

number Required. The number that you want to round. • num_digits Required. The number of 

digits to which you want to round the number argument. INT() • Rounds a number down to 

the nearest integer.  

• Syntax • INT(number) • The INT function syntax has the following arguments: 

 • Number Required. The real number you want to round down to an integer. 

 • Returns the average of the absolute deviations of data points from their mean. AVEDEV is 

a measure of the variability in a data set. • Syntax • AVEDEV(number1, [number2], ...)  

• The AVEDEV function syntax has the following arguments: • Number1, number2, ... 

Number1 is required, subsequent numbers are optional. 1 to 255 arguments for which you 

want the average of the absolute deviations. You can also use a single array or a reference to 

an array instead of arguments separated by commas. nested functions • Using a function as 

one of the arguments in a formula that uses a function is called nesting, and we’ll refer to that 

function as a nested function. For example, by nesting the AVERAGE and SUM function in 

the arguments of the IF function, the following formula sums a set of numbers (G2:G5) only 

if the average of another set of numbers (F2:F5) is greater than 50. Otherwise, it returns 0.  

• The AVERAGE and SUM functions are nested within the IF function. • You can nest up to 

64 levels of functions in a formula. name ,cells/ranges/constants 

 • By using names, you can make your formulas much easier to understand and maintain. You 

can define a name for a cell range, function, constant, or table. Once you adopt the practice of 

using names in your workbook, you can easily update, audit, and manage these names. • 

Name a cell • Select a cell. • In the Name Box, type a name.  

• Press Enter. • There are two types of cell references: relative and absolute. Relative and 

absolute references behave differently when copied and filled to other cells. Relative 

references change when a formula is copied to another cell. Absolute references, on the other 

hand, remain constant no matter where they are copied. Relative references  

• Relative references • By default, all cell references are relative references. When copied 

across multiple cells, they change based on the relative position of rows and columns. For 

example, if you copy the formula =A1+B1 from row 1 to row 2, the formula will become 

=A2+B2. Relative references are especially convenient whenever you need to repeat the same 

calculation across multiple rows or columns. absolute relative mixed cell reference excel  
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• Absolute references • There may be times when you do not want a cell reference to change 

when filling cells. Unlike relative references, absolute references do not change when copied 

or filled. You can use an absolute reference to keep a row and/or column constant.  

• An absolute reference is designated in a formula by the addition of a dollar sign ($) before 

the column and row. If it precedes the column or row (but not both), it's known as a mixed 

reference.  

• You will use the relative (A2) and absolute ($A$2) formats in most formulas. Mixed 

references are used less frequently. • When writing a formula in Microsoft Excel, you can 

press the F4 key on your keyboard to switch between relative, absolute, and mixed cell 

references, as shown in the video below. This is an easy way to quickly insert an absolute 

reference. >, Module from the context menu. • Copy the VBA code (from a web-page etc.) 

and paste it to the right pane of the VBA editor ("Module1" window) 

. • Tip: Speed up macro execution If the code of your VBA macro does not contain the 

following lines in the beginning:  

• Application.ScreenUpdating = False Application. Calculation = xlCalculationManual 

Creating and executing VBA macros embedded in an excel sheet • Then add the following 

lines to get your macro to work faster (see the screenshots above): • To the very beginning of 

the code, after all code lines that start with Dim (if there are no "Dim" lines, then add them 

right after the Sub line): Application.ScreenUpdating = False Application. Calculation = 

xlCalculationManual • To the very of the code, before End Sub: Application.ScreenUpdating 

= True Application. Calculation = xlCalculationAutomatic • These lines, as their names 

suggest, turn off screen refresh and recalculating the workbook's formulas before running the 

macro. Creating and executing VBA macros embedded in an excel sheet  

• After the code is executed, everything is turned back on. As a result, the performance is 

increased from 10% to 500% (aha, the macro works 5 times faster if it continuously 

manipulates the cells' contents).  

• Save your workbook as "Excel macro-enabled workbook”. Press CTRL + S, then click the 

"No" button in the "The following features cannot be saved in macro-free workbook" 

warning dialog. 

 • The "Save as" dialog will open. Choose "Excel macro-enabled workbook" from the "Save 

as type" drop-down list and click the Save button. 

 • Press Alt + Q to close the Editor window and switch back to your workbook.  

 


